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C H A P T E R 1

INTRODUCTION

PowerVisionR is secure, Windows-based, Web-enabled power management software. It is
for people with system and facilities management responsibilities in large networks and
enterprises. Its functions are designed and developed to maximize the ability to easily
monitor and manage every uninterruptible power system (UPS) in facilities
enterprise-wide. Use PowerVision to:

S Monitor the current state of power flowing from the utility through each UPS to its load
equipment, including computers, PBX systems, and network equipment.

S Notify system administrators, facility managers, other key personnel, and users when
changes in alert status occur.

S Make a PowerwareR UPS visible to building management systems via ModbusR
protocol.

S Manage power information by creating graphs and reports of system history.

S Evaluate the system to avoid future crises.

S Shut down remote computer operating systems (including MicrosoftR WindowsR
95/98/Me/NT/2000, NovellR NetWareR and UNIXR systems) as the final step in a power
emergency.

This chapter describes how PowerVision works and discusses data channels. It describes
functions that are available to all users and functions that are password-protected to
ensure security. It also describes the interface for the PowerVision Server and PowerVision
Client software.

How PowerVision Works
PowerVision is client/server software in which information from a UPS is passed to a
server where it is stored. You can access the information from a desktop computer or
directly from the server via the World Wide Web (Internet).

There are two PowerVision applications:

S PowerVision Server for monitoring, collecting, storing, and basic evaluation of event
data (if desired, via the Internet), and for issuing alarms.

S PowerVision Client for studying and evaluating the PowerVision Server data in graph
format, for managing alarms, and for issuing reports.

From the moment the PowerVision Server software is installed with UPS devices, you are
ready to do basic work with PowerVision. Configuring the PowerVision Client software
gives you enhanced capabilities.

PowerVision Client software requires computers running a 32-bit Windows operating
system on a network with TCP/IP on either EtherNet or Token Ring.
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PowerVision Supports Data Channels
In PowerVision the basic unit of input data from the UPS is called a channel. UPS data
channels are classified as meters channels and status channels. Meters channels are analog
values — measurable elements of data from your UPS, such as input and output voltage,
current, frequency, and battery time remaining. Status channels are digital values —
elements that are either true or false, such as device communication, UPS on bypass, and
UPS on battery.

Channel data can be accessed from either application.

A single instance of PowerVision Server can store data for 2,048 channels. If your system
exceeds 2,048 channels, you are prompted to add another computer to your system with
the PowerVision Server software installed.

The number of channels for a device varies with the type of device and the type of
communication (network or serial). For a detailed discussion, see “Planning Your
Installation” on page 21.

Access channel data in the PowerVision Server software from the Devices window.
Figure 1 shows the PowerVision Server Meters Channel Display.

Figure 1. Meters Channel Display (PowerVision Server)
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In PowerVision Client, channel information is accessed from the One-line View’s
Navigation Panel. Figure 2 shows the PowerVision Client Status View.

Figure 2. Status View (PowerVision Client)

When the Status View is active, the Navigation Panel includes access to the Meters View.
When the Meters View is active, the Navigation Panel includes access to the Status View.
Access channel properties by right-clicking a channel.

System Channels
While data channels provide information about a UPS device, system channels provide
information about your PowerVision software system. The alarm functions work like the
alarm functions for data channels. If there is a problem, you are notified. You can enable
and disable alarms and, you can change the alarm limits in the Channel Properties dialog
box.

The System Channels are added to the PowerVision Server Devices window when you add
a device. To add them to PowerVision Client, on the File menu, point to View
Configuration and click Add Views. A wizard opens to guide you through the process.

The reported system channels are:

S Active Client Connections – Indicates the current number of computers running with the
PowerVision Client that are communicating with the computer running the
PowerVision Server software.

S Configuration Backup – Indicates when a change has been made to the PowerVision
Server configuration and its backup is no longer current. A system backup is
recommended.
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S Database Archiving – Reports when the data are being properly logged into the
PowerVision Server database.

S Database Backup – Alarms when a scheduled server data backup operation was
unsuccessful.

S Database Status – Reports the current condition of the PowerVision Server’s database.
This channel alarms if any problems are detected in accessing the database.

S Disk Free Space – Displays the amount of disk space available on the local hard drive
where the PowerVision Server software is installed. This channel alarms when the input
value drops below the low caution and critical limits set in its Channel Properties
dialog box.

S System Alarm – Indicates a system-wide problem such as the server is unable to load a
device driver.

Functions Available to All Users
All users can perform of the following:

S Monitoring via the World Wide Web

S Monitoring via the PowerVision Client

S Receiving immediate alert notification

S Using data to identify trends and predict future events

Monitoring via the World Wide Web
By pointing your Web browser to a computer running the PowerVision Server software,
you can access system information remotely (see Figure 3).

Figure 3. PowerVision Web Interface
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The ability to monitor your system via the Web is especially valuable when you have
configured the PowerVision Server to alert you by page or e-mail at a location where you
do not have immediate access to a PowerVision Client. Information consists of the
following:

S Devices – Color-coded list of all system UPSs (green for normal, yellow for cautionary,
and red for critical). Click on any device to access a list of all channels for the device
with color coding so you can quickly pinpoint the problem.

S Alarms – Color-coded list of all active alarms within the system (yellow for cautionary
and red for critical). Click on any alarm to access details including time of first alarm.

S Reports – Access to current reports including history, log file, notes history, and
previous log file.

Monitoring via the PowerVision Client
Monitoring with the PowerVision Client begins at the System Overview screen with
realistic icons for each PowerVision Server. If there is an alarm condition at a UPS
monitored by a server, the server icon is red or yellow.

The PowerVision Client gives you the power to observe and chart real-time data, manage
alarms, trend historical data, and project potential failure for each connected UPS. There
is always a centralized and current view into the operation of the UPS equipment
supporting your mission-critical applications.

With the System Overview function:

S You can group up to 16 UPSs into a single file to accommodate the monitoring of
approximately 64 UPSs at once.

S You get the information you need to take preventive action.

S You have additional capabilities as described in “Protected Functions” on page 14.

Receiving Immediate Alert Notification
When a PowerVision Server detects an alarm condition on a monitored UPS, the following
happens at each PowerVision Client that is connected to that server:

S The PowerVision Alarm Notification dialog box appears on top of the screen. You can
quickly navigate to the system overview or to the Alarm Notification dialog box for data
on the problem and the unit in trouble.

S There is an audible alarm. Sounds can range from *.wav files to voice recordings with
specific instructions on how to respond in the event of a particular alarm.

S If the Display System Level Alarm Notification Dialog check box is enabled in the
System Settings dialog box, the Alarm Notification dialog box is displayed on all
machines throughout the system.

S If you have configured message management functions on either the PowerVision
Server or the PowerVision Client, selected personnel can be notified by page or e-mail
in the event of specified alerts (see “Notifying Personnel of Alarms and Alerts” on
page 61).
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Using Data to Identify Trends and Predict Future Events
The PowerVision Client’s data analysis capabilities are based on the statistical information
underlying the equipment you monitor with the PowerVision Server. In many cases, this
data can help you understand problems and take corrective action to prevent failures that
could jeopardize the availability of your UPS equipment. Data is classified as follows:

S Single-Point Analysis – Allows you to examine individual data points on a graph,
including the start date, the trace’s identifying legend, and the channel’s display units
and average value.

S Range Analysis – Allows you to examine data over a period of time and includes
additional statistics such as minimum, maximum, and mean to ensure that you have
complete knowledge about your site.

Protected Functions
To protect the PowerVision data and configurations from inadvertent modifications, many
functions are password-protected. In addition, some functions are limited to the
PowerVision Server, which is not available on all machines. The following functions are
protected:

S System administration settings

S PowerVision Server database backup and restoration

S Alarm and message management (including channel parameters)

S Server administration

S Report run and retrieval

S Emergency shutdown of remote computer operating systems

System Administration Settings
Settings that are controlled by a system administrator include the system log, system
settings, serial numbers, client configuration backup and restoration, server management,
channel property modification, and report management.

PowerVision Server Database Backup and Restoration
To protect the PowerVision Server database in the event of hard disk problems, you can
schedule automatic backups. For network installations, it is advisable to archive daily to a
second hard drive and to a file server or tape backup. If PowerVision Server and
PowerVision Client reside on the same computer, it is recommended to archive daily to a
tape backup. The backup archive includes PowerVision data files, and logged alarms and
notes. Configuring backups is a password-protected administrative function.

Alarm and Message Management Functions
The PowerVision software comes with an extensive capability for tailoring the alarm and
message functions to meet specific needs. In PowerVision Client, you can:

S alter the channel parameters for such things as description and priority settings

S activate message delays

S disarm or disable messages

S acknowledge or suspend an alarm

S reactivate an alarm

Configuring such settings requires an administrative password.
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Message Management is an advanced PowerVision function that establishes an automatic
escalation procedure in response to user-specified alarms. By adjusting the channel
message settings, you can choose a particular list of personnel to be informed that the
input is reporting an alarm condition. Specific notification lists can be assigned.
Configuration of message management properties requires an administrative password.

Server Administration
This includes creating and removing servers and updating channel parameters. Servers are
configured by name or address, or both. Advanced properties include offline sounds,
update intervals, and time differential between the machine running the PowerVision
Server software and the machine running the PowerVision Client software.

Report Functions
The PowerVision Server keeps binary log files that you can access from the PowerVision
Client for insights into system performance. Reports are reviewed, printed, and distributed
to concerned departments or incorporated into other documents.

PowerVision report formats are:

S Alarm History – Alarms detected over the last day, week, month, or specified period.

S Channel – Parameters for channels on a server or a selected device.

S Log File – Recorded events since the last system reset.

S Notes History – Notes logged over the last day, week, month, or specified period.

S Previous Log File – Events recorded in the previous PowerVision Server session.

S System Configuration – All configured devices, their operational parameters, and current
interface software version.

S System Up-Down – Each time the PowerVision program was launched and terminated.

Emergency Computer Shutdown
In situations where the system is on UPS battery power and the UPS battery power is low,
it is possible to program an emergency shutdown of remote computers (most operating
systems are supported). Before the shutdown would be implemented, the appropriate
system management personnel would be notified and given time to react.

PowerVision Server Interface
The PowerVision Server provides access to the Devices window and the Message
Management window. Each window has a title bar and a menu bar. The default window is
the Devices window (see Figure 4).

Figure 4. PowerVision Server Devices Window

The Devices window presents a concise overview of the power situation. A green icon
signifies equipment that is operating normally. Icons that are red or yellow indicate
problems. To investigate a problem, expand the listing for a device.
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NOTE Right-clicking in the Devices window or the Message Management window opens a contextual
menu with commonly used options.

If you click Message Management on the Window menu, the Message Management
window opens. Opening the Message Management window adds the Messages menu to
the menu bar and the Messages toolbar below the menu bar. You can highlight and stop a
call, call again, remove the entry, or access a list of status messages for the channel.
Commonly used functions are available in an icon bar (see Figure 5).

Figure 5. Message Management Window

PowerVision Client Interface
In PowerVision Client, all windows have a title bar with the name of the application, a
menu bar with the available menus, and the standard ten-button toolbar (see Figure 6).

Figure 6. Title Bar, Menu Bar, and Standard Toolbar

NOTE Right-clicking in a window opens a contextual menu with commonly used options for that window.
In some cases, it may be necessary to highlight an item in the window before all options are available.

Standard Toolbar
The standard toolbar consists of the following icons:

S New – Open a new graph or burst graph

S Open – Open views, data analysis graphs, or reports

S Save – Saves the active view, graph, burst graph, or report as a PowerVision file.

S Cut – Removes the selection to the clipboard

S Copy – Copies the selection to the clipboard

S Paste – Positions the selection from the clipboard at the insertion point

S Print – Produces a hard copy of the active screen

S About – Opens a dialog box with copyright and version information

S Help – Opens the online help program

S System Overview – Opens the System Overview

NOTE You can drag the standard toolbar to any position on your screen.
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View Navigation Toolbar
This two-button toolbar is active when the System Overview, Folders View, One-line
View, Meters View, or Status View are open. The icons are as follows:

S Overview – Opens the next higher view in the hierarchy, where the Status View is the
lowest, followed by the Meters View, the One-line View, the Folders View, and the
System Overview.

S Graph – When you highlight a channel and click this icon, a graph opens.

NOTE You can drag the View Navigation toolbar to any position on your screen.

Alarm Management Window
The menu bar on the Alarm Management window includes the Alarms menu. Redundant
options are available on the Alarm Management toolbar and by right-clicking (see
Figure 7).

Figure 7. Title Bar, Menu Bar, and Alarm Management Toolbar

Access the Alarm Management window from the Window menu by clicking System Alarms
(see “What To Do In Case of Alarm” on page 47).

Server Management Window
The menu bar on the Server Management window includes the Servers menu. Redundant
options are available by right-clicking (see Figure 8).

Figure 8. Title Bar and Menu Bar for Server Management Window

Access the Server Management window from the Window menu by clicking Server
Management.

Message Management Window
The menu bar on the Message Management window includes the Messages menu.
Redundant options are available on the Message Management toolbar and by
right-clicking a message (see Figure 9).

Figure 9. Title Bar, Menu Bar, and Message Management Toolbar

Access the Message Management window from the Window menu by clicking Message
Management (see “Notifying Personnel of Alarms and Alerts” on page 61).
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Graph Window
When you open a graph, the menu bar includes the Graph menu. Redundant options are
available on the Graph toolbar and by right-clicking (see Figure 10).

Figure 10. Title Bar, Menu Bar, and Graph Toolbar

See “Graphing Your Data” on page 73.

Status Bar
The Status Bar at the bottom of your Windows desktop shows the number of cautionary
(yellow), critical (red), and acknowledge (blue) alarms (see Figure 11).

Figure 11. Status Bar

PowerVision User Tips
S Install PowerVision only on the computer you designate for PowerVision tasks. In

many cases, this can be handled on one computer. This computer can also be used for
non-PowerVision tasks.

S All UPS devices throughout your facility are added at the computer running the
PowerVision Server software. On the Admin menu, click Start Server Config. On the Edit
menu, click Install Device. A wizard opens to guide you through the process.

S Views of the devices are configured at the computer running the PowerVision Client
software. On the File menu, point to View Configuration and click Add Views. A wizard
opens to guide you through the process.

S In the PowerVision Client, it is recommended that configuration backups be performed
after the initial system configuration and after any modifications to the configuration or
settings.

S Changing the administrator password – On the Users menu, click Change Password for
Admin. Enter changes in the Change Password for Admin dialog box.

How the User’s Guide Is Organized
The PowerVision User’s Guide covers the use of PowerVision Server and PowerVision
Client after installation and device setup. The manual is organized into chapters as
follows:

S Chapter 1, Introduction – How PowerVision works, data channels, functions available to
all users, protected functions, about the interface, tips for users.

S Chapter 2, Installation – Planning your installation, installing and configuring, system
configuration.

S Chapter 3, Monitoring Your System – How to keep in touch with the operating status of an
entire enterprise, a network segment, or the elements of the power environment of an
individual UPS. How the PowerVision Client works. How the PowerVision Server
works. How to check on your system remotely via the World Wide Web. How to check
on your system with a personal digital assistant (PDA).
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S Chapter 4, What To Do in Case of Alarm – Acknowledging an alarm, determining the cause
of an alarm, delaying action on an alarm, and accessing active alarms on the Web.

S Chapter 5, Changing the Way Your System Issues Alarms – Changing the way your system
notifies you, disabling alarm sounds, and modifying channel properties.

S Chapter 6, Notifying Personnel of Alarms and Alerts – Configuring groups of users who can
be notified by page, e-mail, and other means.

S Chapter 7, Graphing Your Data – Creating a simple graph, optional changes and
enhancements, graph styles.

S Chapter 8, Creating Records of System Events – Reports, running and retrieving reports,
notes, and accessing reports on the Web.

S Chapter 9, Making Changes to Your System – Adding and removing devices, connecting
and removing a server, adding a view, reconfiguring server properties, authorizing
users, changing device property settings, changing the administrator password, setting
server properties in the PowerVision Server software, and specifying backup file details.

S Chapter 10, Emergency Computer Shutdown – Steps for configuring an emergency
computer shutdown and disabling the shutdown function.

S Chapter 11, Integrating Building Management Software and PowerVision – Accessing UPS
data through building management software and the PowerVision Modbus Gateway.
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C H A P T E R 2

INSTALLATION
This chapter is a step-by-step guide:

S Planning your installation, fitting PowerVision into your network, communication
options, client-to-server access options, licensing, verifying TCP/IP protocol
installation, system requirements, making a list of network details.

S Installing the PowerVision Server and PowerVision Client software.

S Configuring and adding devices to the PowerVision Server, configuring the
PowerVision Client, and configuring autoviews of your equipment for display in the
System Overview or Folders View.

S Installing the PowerVision Client software on a remote computer.

S Configuring remote PowerVision Client installations and configuring equipment
autoviews for display in the System Overview or Folders View.

To install the Powerware Shutdown Agent, see page 114.

Each time you add a device to your system, install the device on the PowerVision Server
software and configure views for the device on the PowerVision Client software.

Planning Your Installation
Before you install PowerVision, you should understand the following:

S How PowerVision will fit into your network.

S Computer-UPS communication.

S Options for accessing PowerVision Client.

In addition, you should verify that TCP/IP is enabled on all machines and that system
requirements are met. It is recommended that you make a list of your devices, computer
IP addresses, and communication settings.

Fitting PowerVision Into Your Network
Before installing PowerVision, designate a computer for monitoring UPSs, storing data,
and other PowerVision tasks. This computer can also be used for non-PowerVision tasks.
Optionally, you can designate two computers, one for the monitoring and storage
(PowerVision Server functions) and the other for control functions (PowerVision Client
functions) from another location.
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To set up your facility for PowerVision:

1. Install the PowerVision Server and PowerVision Client software on the computer
or computers you designate for PowerVision. See “Installing and Configuring” on
page NO TAG.

2. Add your facility UPS devices to the PowerVision Server (maximum 2,048
channels). For more information on data channels, see “PowerVision Supports
Data Channels” on page 10. Table 1 lists the UPSs supported by PowerVision and
the number of data channels each supports.

UPSs vary in size and the amount of data they generate. A Powerware 9330 UPS
has 107 data channels while a Powerware 9305 UPS in a network configuration
has just 31 channels. Since an instance of the PowerVision Server can store only
2,048 data channels in its database, you can add 19 Powerware 9330 UPS devices
or you can add 66 Powerware 9305 UPS devices. To add more data channels, you
must add another computer with the PowerVision Server software installed.

For more information on installing devices, see page 29.

3. Add a view for each UPS device to the PowerVision Client software. See
“Autoview Configuration” on page 32.

Table 1. Powerware UPSs and Data Channels

Powerware UPS Data Channels

Powerware 9 Prestige 35

Powerware 9110 Network 20

Powerware 9110 Serial 21

Powerware 9120 35

Powerware 9125 40

Powerware 9150 HV N Network 25

Powerware 9150 HV N Serial 39

Powerware 9150 HV S Network 23

Powerware 9150 HV S Serial 37

Powerware 9150 LV 37

Powerware 9170+ (single-phase) 32

Powerware 9170+ (split-phase) 37

Powerware 9305 Network 31

Powerware 9305 Serial 57

Powerware Plus 18 - 36 kVA 36

Powerware 9315 40–500 kVA 65

Powerware 9315 750 kVA 63

Powerware 9330 107

Powerware HotSync SBM (no MBP) 115

Powerware HotSync SBM 118

Powerware HotSync UPM 69

Powerware Modbus Gateway 1
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While you have many options in configuring your system, two common installations are:

1. A single-server system with one designated computer acting both as the server
and the client (see Figure 12).

Figure 12. Single-Server PowerVision System

2. A multi-server system serving an installation such as a campus or multiple field
locations. Such a system comprises several single-server systems. A master client
would be installed at the headquarters to view the individual single-server systems
in this distributed campus or multiple location work place. One client can view
16 systems, each displayed on the System Overview as a folder with 16 devices per
folder for a maximum of 256 devices (see Figure 13).

Figure 13. Multi-Server PowerVision System
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Computer-UPS Communication Options
The essential element of power management software in a UPS-supported computer
network is communication between the UPS and a computer running the PowerVision
Server software. Communication can be by the serial cable supplied with the UPS, or if an
ethernet network is available, by ConnectUPSt to the network, as follows:

S Serial Communication – Use the cable supplied with the UPS when the distance between
the PowerVision Server and the UPS is less than 50 ft. Use an RS-232/422 converter
(part number 41158) when the distance exceeds 50 ft.

S Network Communication (single-module) – For systems with one UPS, the appropriate
ConnectUPS devices are as follows:

- For all Powerware reverse transfer (standalone) 9315 UPSs and IPM BP-III UPSs, use
the ConnectUPS-9315 (part number 103001458).

- For all Powerware UPSs with a built-in communication slot, use either the
ConnectUPS-MX (part number 05146288-5501) or the ConnectUPS Web/SNMP
Card (part number IPK-0330). Note that when PowerVision is connected to the
ConnectUPS Web/SNMP Card, all HTTP (Web) and SNMP functions are disabled.

- For all other Powerware and IPM UPSs, use the ConnectUPS-M (part number
101690002-001).

Obtain the IP address and program it into the ConnectUPS adapter. Consult your
network administrator, if necessary.

S Network Communication (multi-module) – For systems with more than one UPS, obtain
the appropriate serial hub/Ethernet converter for your system as follows:

- For all Powerware 9315 Hot Sync parallel redundant systems, Hot Sync parallel
capacity systems, and all other parallel UPS configurations with up to four modules
including the system bypass module, use the 4-port serial hub/Ethernet converter
(part number 41147).

- For systems with up to eight modules including the system bypass module, use an
8-port serial hub/ Ethernet converter (part number 41148).

If you use the 4-port serial hub/Ethernet converter or 8-port serial hub/Ethernet
converter, the computer must be running Windows NT. When configuring, use either
the IP address or the MAC address.

Client-to-Server Access Options
The PowerVision Client can access a PowerVision Server over a local area network. It is
also possible to access a server from a remote location by means of a dedicated modem,
the World Wide Web, or a personal digital assistant. For details on configuring your
system for Web access, see “Remote Monitoring via the World Wide Web” on page 41.
For details on using a PDA in your system, see “Remote Monitoring by PDA” on page 46.

In addition, the PowerVision Client software can be installed on a system administrator’s
computer in one city, using Windows Dial-up Networking or a computer network
connection, and monitor a computer in another city. This requires a dedicated modem
and connection for full-time operation.

Licensing PowerVision
Licensing is provided in the form of a license key number. If you obtained the software
when you purchased a UPS, you should have received a license key number. Otherwise,
you can install the software on a 30-day trial basis. If necessary, your PowerVision
representative can help you obtain a license key number.
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Licensing is required to run the PowerVision Server. It is not required to run the
PowerVision Client.

1. On the Admin menu, click Change License. The PowerVision License dialog box
opens.

2. Type your license key number in the space provided.

3. Click OK to enter the number or Cancel to return to the program.

Verifying TCP/IP Protocol Installation
1. On the Windows Start menu, point to Settings and click Control Panel. The

Control Panel opens.

2. Double-click the Network icon. The Network dialog box opens.

3. On the Protocols tab, verify that the TCP/IP protocol is listed.

NOTE TCP/IP protocol must be enabled on any computer running the PowerVision Server or PowerVision
Client software. If necessary, refer to your Windows online help program to install and configure TCP/IP.
You will need to know the network address for each computer.

System Requirements
The following minimum system configuration is necessary:

S A computer with mouse, CD-ROM drive, and a 200 MHz Pentium processor or
compatible (Recommended: 366 MHz)

S An 800 x 600 VGA monitor (Recommended: 17I, 1024×768, 256-color super VGA
with a 1 MB video card)

S Microsoft Windows 95/98, Me, NT, or 2000 operating system

S 32 MB of RAM (Recommended: 64 MB)

S 256k CPU cache

S 250 MB of available hard disk space (Recommended: 1.5 GB; depending on the number
of devices being monitored)

S Network interface card for Ethernet or Token-Ring

Optional equipment includes:

S ConnectUPS network adapter

S Serial hub expander for device connections to an Ethernet network

S Tape backup for archiving data and system configurations

S Local printer for hard copy outputs

S Sound card for assigning sounds to specific alarm conditions

S 28,800-baud modem for remote access

Listing Server and Device Details
For use in the initial installation and to accommodate future requests, it is recommended
that you keep the following information for each network server:

S Server Name – The server as it is identified in your facility.

S Facility – The building in which it is located.

S IP Address – The IP address for the computer running the PowerVision Server software.

S Computer Name – The computer running the PowerVision Server software.
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For each UPS device that you configure for viewing from the PowerVision Server or
PowerVision Client attached to the server, add the following:

S UPS Type – The make, model, and kVA rating of the added UPS (the UPSs seen in the
PowerVision Server Devices window).

S Location/Purpose – Information that PowerVision Server and PowerVision Client will
display so you know what and where it is.

S Connection – For network computers, the IP addresses. For serial connections, the
computer COM port used for communication with the UPS device. Include settings for
baud rate, parity, data bits, stop bits, and handshaking flow control.

S Critical Loads – All equipment the UPS provides power for. Include the IP address when
the equipment is a server.

A list for a server in a typical facility installation is shown in Table 2.

Table 2. Typical Server Information List

Server Name Facility IP Address Computer Name

PV Server #1 San Diego 127.0.0.101 Cornelius

UPS Type Location/Purpose Connection Critical Loads

Powerware 9315 - 50 kVA Data Center UPS 127.0.0.102 Nortel Phone Switch

Honeywell Temp Control

Cisco Router

Lotus Notes 127.0.0.103

Apache 127.0.0.104

CAD/CAM 127.0.0.105

Ingrid 127.0.0.106

Bill 127.0.0.107

Barnhast 127.0.0.108

Powerware 9330 - 30 kVA Pump Room UPS 127.0.0.109 Landis & Gyr Flow Meter

Johnson Metasys Control

Harvard Sys Valve Sensor

Powerware 9125 Bill’s Desk COM Port 1 Bill 127.0.0.110

Monitor

Printer



Installation

27PowerVision® Software User’s Guide S Rev A www.powerware.com

Powerware UPSs supported by PowerVision default to the baud rate shown in Table 3
with no parity, 8 data bits, 1 stop bits, and no handshaking.

Table 3. Baud Rates of Powerware UPSs

Powerware UPS Baud Rate Mode Remarks

Powerware 9 Prestige 2400 Printer

Powerware 9110 2400

Powerware 9120 9600

Powerware 9125 9600

Powerware 9150 1200

Powerware 9170+ 9600

Powerware 9305 1200

Powerware Plus 18 - 36kVA 9600 Binary Computer See Note 1.

Powerware 9315 - 40–750 kVA 9600 Computer See Note 2.

Powerware 9330 9600

Powerware HotSync Parallel Capacity SBM or UPM 9600 Computer See Note 2.

NNNNOOOOTTTTEEEESSSS
1. Use terminal software to verify that the mode is set correctly.
2. Set the communication mode through the UPS front panel.

Installing PowerVision
Before installing PowerVision, exit all Windows applications.

1. Insert the Software Suite CD into the CD-ROM drive of the computer to be
installed. The Main menu opens.

2. Click UPS Software Installation Wizard. When prompted, select your UPS Model,
your Windows operating system, and PowerVision application. Alternatively, run
the install program after clicking Run on the Windows Start menu and navigating
to setup.exe in the PV directory on the Software Suite CD. The Welcome dialog
box opens.

3. After reading the Welcome dialog box message, click Next. The End-User License
Agreement (EULA) opens.

After reading the EULA, click Yes. The Choose Destination Location dialog box
opens.

4. Either accept the default Destination Folder, or specify another. Click Next. The
Setup Type dialog box opens.

5. In the Setup Type dialog box, choose one of the following:

S Remote Client – Installs a remote instance of the PowerVision Client software.
Requires you to install the PowerVision Server software on a different
computer.

S Server and Client – Installs the PowerVision Server and PowerVision Client
software on the local machine.

6. Click Next. Installation begins and files are copied. When installation is complete,
the Setup Complete dialog box opens.
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7. Read the Setup Complete dialog box and click Finish. Restart Windows if
prompted. The installation program closes.

8. Continue to the following section, “System Configuration.”

System Configuration
System configuration is guided by wizards for each step including server configuration,
device installation, client configuration, and autoview configuration. Finishing one wizard
automatically starts the next until all are complete.

If you installed the server and client (see Step 5 in the previous section), start by
configuring the PowerVision Server in the following section. If you installed the remote
client, start with client configuration (see “Client Configuration” on page 31).

Configuring the PowerVision Server
PowerVision Server configuration gives you the option to password-protect your system.

1. Start the PowerVision Server. The screen for Server Configuration Wizard Step 1
of 4 opens.

2. Read the information on the screen and click Next. The screen for Step 2 of 4
opens (see Figure 14).

Figure 14. Server Configuration Wizard Step 2 of 4

3. Enter the password in the Password and Verify Password fields (or leave them
blank) and click Next. The third configuration screen opens.

4. Read the third configuration screen and click Back to change the password, or
Finish to save the Server Configuration settings. Click Next. You are advised that a
30-day trial license has been granted.

5. Read and close the 30-day trial license notice. The first screen of the Device
Installation Wizard opens.
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Device Installation
Device installation adds devices to the PowerVision Server Devices window. The Device
Installation Wizard guides the procedure. The first screen opens automatically after you
configure the PowerVision Server.

1. Read the first Device Installation Wizard screen and click Next. The next Device
Installation Wizard screen opens, asking you to select the type of device you want
to add (see Figure 15).

Figure 15. Device Installation Wizard Select the Type of Device

2. Select the device type and click Next. The next Device Installation Wizard screen
opens, asking you to enter a unique name for the device (see Figure 16).

Figure 16. Device Installation Wizard Enter a Unique Name
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3. Accept the suggested name for the device or enter your own name, up to 24
characters, and click Next. The next Device Installation Wizard screen opens, with
check boxes for the type of communication (network or serial). See Figure 17.

Figure 17. Device Installation Wizard Communication Type Selection

4. Identify the type of connection between the PowerVision Server and the UPS by
selecting one of the following:

S Network (ConnectUPS Web/SNMP Card or other ConnectUPS) – If you select
Network, you must also indicate whether you have a ConnectUPS Web/SNMP
Card or other ConnectUPS. Clicking Next opens the Port Settings dialog box
where you enter the IP address of the computer running the PowerVision
Server software.

S Serial – Selecting Serial and clicking Next opens the Port Settings dialog box
where you indicate the computer COM port and verify the port settings.
Change the port settings if necessary. See Table 3 on page 27 for Powerware
UPS baud rates.

5. Click Next to close the Port Settings dialog box. The system verifies the settings
you have entered, and the Enable Emergency Computer Shutdown screen opens.

6. Click Next to close the Enable Emergency Computer Shutdown screen. The
system verifies the settings you have entered, and the Identification screen opens.

7. If verification was successful, the Identification screen presents a list of settings. If
verification was not successful, the Identification screen explains the problem.
Click Next. The final Device Installation Wizard screen opens.

8. To abort the installation, click Cancel. To complete installation, click Finish. The
new equipment appears in the Devices window. You are prompted to install
another device.

9. After you install all devices, click No when prompted to install another device.

NOTE To start future device configurations: On the Admin menu, click End Database Session then click
Start Server Config. On the Edit menu, click Install Device. Before you configure a device, it must be
communicating with a computer and running normally.



Installation

31PowerVision® Software User’s Guide S Rev A www.powerware.com

Client Configuration
Before you configure a client, the PowerVision Server software must be running.

Client configuration gives you the option to create a password. It also enters into the
system the name and IP address of a server. The Client Configuration Wizard guides the
procedure. If you are installing the PowerVision Server and the PowerVision Client
software, the first screen opens automatically after you complete Device Installation. If
you are making a remote installation of the PowerVision Client software, the first screen
opens automatically after you complete installation and click Finish.

1. Read the Client Configuration Wizard screen and click Next. The screen for Step 2
of 4 opens (see Figure 18).

Figure 18. Client Configuration Wizard Step 2 of 4

2. Enter the password in the Password and Verify Password fields (or leave them
blank) and click Next. The third configuration screen opens (see Figure 19).

Figure 19. Client Configuration Wizard Step 3 of 4
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3. Enter a name for the server, its IP address, and a description of the server. This
name should clearly identify the server as it will be used in all displays and on
reports. The default address of 127.0.0.1 assumes the PowerVision Server and the
PowerVision Client software are installed on the same computer. If they are
installed on different computers, correctly enter the IP address of the PowerVision
Server; otherwise, the client will not be able to establish communication with the
server. Click Next. The fourth screen opens.

NOTE If the Install Remote Client was chosen from the Install menu, the IP address of the PowerVision
Server must be known. See your PowerVision Server Table information for identifying possible servers on
your network.

4. Click Back to revise any settings if necessary, or click Finish to complete
configuration. Connections are established and the Autoview Configuration
Wizard opens.

Autoview Configuration
Autoview Configuration creates icons in the System Overview or Folders View. The
Autoview Configuration Wizard can be used to create new folders.

The PowerVision Server software must be running and actively collecting data to be able
to establish client connections and configure a view. Also, verify that Start Database on the
Server’s Admin menu is enabled.

1. Read the Welcome screen and click Next. The screen for Autoview Configuration
Wizard Step 2 of 5 opens (see Figure 20).

Figure 20. Autoview Configuration Wizard Step 2 of 5
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2. Indicate where you want the device icon to be located by selecting one of the
following:

S Add a device on the system overview – This creates an icon for the device that
you can see on the PowerVision Client System Overview.

S Add this device to a new folder – This creates an icon for the device inside a new
folder that you can see on the PowerVision Client System Overview.

S Add this device to an existing folder – This creates an icon for the device inside a
previously created folder that you can see PowerVision Client System
Overview.

After you make your selection, click Next. The screen for Autoview Configuration
Step 3 of 5 opens, asking you to select the server and device for which you would
like to create views (see Figure 21).

Figure 21. Autoview Configuration Wizard Step 3 of 5

3. Select the server from the Server list and select the Device Name of the
equipment. Click Next. The screen for Autoview Configuration Wizard Step 4 of 5
opens, asking you to select the type of equipment that corresponds to the device
selected for view creation (see Figure 22).

Figure 22. Autoview Configuration Wizard Step 4 of 5
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4. Select the Equipment Type that corresponds to the device configured in Step 3
of 5 and click Next.

5. The chosen server, device, folder (if applicable) and equipment are summarized
on the final screen. Verify that the information is correct. If an entry is wrong,
click Back and return to the appropriate Autoview Configuration screen and
change it. Click Finish to complete the configuration process.

A Client Progress dialog box reports the successful completion of configuration
and you are given the option to Configure Another Device, or exit the wizard. The
Overview displays the newly configured Device(s).

NOTE To reconfigure views in an existing system, run the PowerVision Client software. On the File menu,
point to View Configuration and click Add Views. The Autoview Configuration Wizard starts.

Clearing the Auto-Start Client Option
By default, PowerVision Client starts automatically when you start PowerVision Server. If
you do not need PowerVision Client, use the following procedure to clear the auto-start
client option from PowerVision Server:

1. On the Admin menu, click End Database Session then click Start Server Config.

2. On the Admin menu, click Server Properties. The Server Properties dialog box
opens.

3. In the Server Properties dialog box, clear the Auto-Start the Client check box.

4. On the Admin menu, click End Server Config. The database session resumes.

Related Documentation
See “Specifying Backup File Details” on page 111.
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C H A P T E R 3

MONITORING YOUR SYSTEM
PowerVision tells you the status of all the UPS devices that are installed on your system.
There are various levels of monitoring ranging from an overview of your total network or
enterprise down to the individual elements, or channels, of your UPS.

This is especially useful in alarm situations. Color-coded icons and text messages show
you at once if operations are normal (green), cautionary (yellow), or critical (red). You
can access channel properties to explore the cause of an alarm.

PowerVision comes with several monitoring options:

S Monitoring with PowerVision Client

S Monitoring with PowerVision Server

S Remote monitoring via the World Wide Web

S Remote monitoring by personal digital assistant

In a PowerVision system, the PowerVision Server maintains database files of channel data
from UPS devices. There are two kinds of channels, meters and status. Channel data can
be monitored from the PowerVision Client, or by contacting the PowerVision Server via
the World Wide Web via computer or PDA device.

Monitoring (PowerVision Client)
When you start the PowerVision Client software, the default view is the System Overview
(see Figure 23).

Figure 23. System Overview (PowerVision Client)
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The System Overview makes it visually easy to quickly determine the status of your
equipment. It is populated with icons (and optionally folders) representing the equipment
being monitored. Blinking icons indicate a problem. The equipment is identified by the
name you gave it during server device installation.

The System Overview consists of a menu bar, a toolbar, a left pane with a Navigation
Panel, and a right panel with icons for all devices in your system that are visible to your
PowerVision Client. There is a status bar at the bottom.

To view your system in greater detail:

S Double-click a device icon – On the System Overview, double-click a device icon to
access the device’s One-line View. You can also double-click a folder icon (if
configured) to access the device icons you have placed in the folder. From the One-line
View, you can navigate to the Status View or Meters View for details and individual
channels.

Beyond the System Overview, PowerVision Client has several options for detailed
studies of the devices on your system, including:

- One-line View – The operation of the device selected in the System Overview.

- Meters View – The state and current value of each digital channel of the device
represented in the One-line View.

- Status View – The channel state and current value of each digital input for the device
represented in the One-line View.

- Optional Folder Overview – An optional convenience feature to give you faster access
to device information.

S Select a Window menu option – On the Window menu, click Hierarchy, System
Overview, System Alarms, Server Management, Message Management, or any screens
accessed during the present session.

S On the File menu, click Open – Use the Open dialog box to access views, and any reports
and graphs you have created.

NOTE To return to the System Overview from anywhere within the PowerVision Client software, click PV
System Overview on the Window menu.
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One-line View
When you double-click a device in the System Overview, the One-line View opens,
illustrating its operation (see Figure 24).

Figure 24. PowerVision Client One-line View

For a UPS, the display elements summarize its current value and operational status, the
flow of power through the equipment, and the battery time remaining. The color of the
flow and one-line components reflect any alarm conditions on the equipment.

The display is specific to the UPS.
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Meters View
The Meters View, accessed from the One-line View, lists the equipment’s digital channels,
reporting the state and current value of each (see Figure 25).

Figure 25. Meters View (PowerVision Client)

Available functions on the Meters View include:

S Creating a graph – Select a meters channel, right-click, and click Graph. A graph opens.

S Reviewing or changing channel properties – Select a meters channel, right-click, and click
Channel Properties. The Channel Properties dialog box opens for the selected channel.

The Navigation Panel furnishes access to the Status View, One-line View, Alarm
Management dialog box, and System Overview.
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Status View
The Status View, accessed from the One-line View, shows digital inputs and visually
reports the corresponding channel state and current value of each (see Figure 26).

Figure 26. Status View (PowerVision Client)

Available functions on the Status View include:

S Creating a graph – Select a status channel, right-click, and click Graph. A graph opens.

S Reviewing or changing channel properties – Select a status channel, right-click, and click
Channel Properties. The Channel Properties dialog box opens for the selected channel.

The Navigation Panel furnishes access to the Meters View, One-line View, Alarm
Management dialog box, and System Overview.

Folder Overviews
In the PowerVision Client software, you can arrange the servers in your system into
groups with a folder for each. Folders are an optional convenience feature. You may wish
to group devices by department, area, floor, building, or other location. You can install up
to 16 device icons in a folder, allowing a total of 64 monitored devices. Use the following
procedure to create a new folder:

1. On the File menu, point to View Configuration and click Add Views or Remove
Views.

2. If you click Add Views and the Autoview Configuration Wizard starts, click Next.

3. Click Add this device to a new folder.

4. Enter a name for the folder.
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Monitoring (PowerVision Server)
PowerVision is a client/server application. The PowerVision Server functions as a
centralized storage location for information and the PowerVision Client retrieves and
displays that information.

There may be situations where it is convenient for you to access alarm details and monitor
your system using the PowerVision Server from:

S A desktop where PowerVision Server software is running.

S A computer or other Web access device that is not running the PowerVision Server
software.

Desktop Monitoring
The Devices window, selected from the PowerVision Server Window menu, lists all
equipment the PowerVision Server is monitoring. Each listing is preceded with a
color-coded icon to provide a quick overview of channels that are functioning normally
and channels that require attention (see Figure 27).

Figure 27. Devices Window (PowerVision Server)

Devices and channels are nested and shown in a hierarchical tree structure. Circle icons
identify Meters (analog) channels and square icons identify Status (digital) channels. The
color of the icon reflects its current alarm state.

To check properties for a channel, select the channel and click Properties. The Properties
dialog box opens (see Figure 28).

Figure 28. Properties Dialog Box for Input Voltage Phase A/B Meters Channel
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Remote Monitoring via the World Wide Web
Using the Web, you can monitor your UPS devices from anywhere – your desk, a Web
kiosk, or on the road via a Palmt VII or Palm VIIx handheld. To enable PowerVision
Server for Web access, type the server’s IP address in the web browser, and the Server
Home page opens with access to status information on your devices and their channels,
and also alarm details and reports.

An HTTP server is a non-encrypted, non-secure server although the PowerVision Server
software allows you the option of setting passwords for access to data and for
acknowledging or rearming alarms. For systems with more stringent security
requirements, the application supports 128-bit passwords with the secure sockets layer
(SSL) protocol. See “Ensuring the Security of Your Data” on page 42.

Configuring HTTP Server Properties
1. On the Admin menu, click HTTP Server. The HTTP Server Properties dialog box

opens.

2. On the General tab, you have the following options:

S Enable the HTTP (Non-Secure) Server – A check in this check box indicates that
HTTP server access is enabled.

To enable or disable the HTTP server, you must restart the PowerVision Server
software.

S Port to Listen on for HTTPS – It is recommended that you accept the default, 80.

S Max Number of Connections

S Refresh Interval

3. On the Authentication tab, you have the following options:

S User Name – Enables the authentication feature for viewing the HTTPS server.

S Password – Protects access to UPS data.

S Confirm Password

S Enable Acknowledge/Rearm – Allows authorized users to use the Internet to
acknowledge or rearm alarms. Password protection is optional.

NOTE If neither password is set, anyone with Internet access to the computer running the PowerVision
Server software can acknowledge or rearm alarms.
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4. On the Connection Keep-Alive tab, you have the following options:

S Max Number of Requests – Specify the Max Number of Requests allowed to web
browsers that support the Keep-Alive function. Keep-Alive maintains
connection with the PowerVision HTTP or HTTPS server when the request for
information is received within the specified timeout period.

S Timeout – Specify the period (in seconds) for web browsers to submit requests
for HTTP or HTTPS server information before the connection is terminated.

5. On the Appearance tab, you have the following options:

S Border

S Browser Display Format – Browser-based, the default, attempts to determine the
type of browser making the connection and present HTTP or HTTPS server
information in an appropriate format. This setting is useful when multiple
browser types may access the server.

Ensuring the Security of Your Data
As part of the process of enabling secure Internet access to your PowerVision Server data,
you have the following options:

S Develop an internal certificate authority using PowerVision.

S Use an external certificate authority such as VeriSign.

The PowerVision Server software includes an Open SSL program that you can use to
create your server certificate with private key password. Once you create your server
certificate and private key password, you are ready to configure your secure server
(HTTPS).

Creating a Server Certificate and Private Key Password
1. Run openssl.exe.

This program is located in:

c:\Program Files\Invensys Powerware\PowerVision\Server

When you run the program, a command window opens displaying the OpenSSL
prompt.

2. Generate a private key password.

S At the OpenSSL> prompt, type: genrsa -des3 -out server.key 1024.

S When prompted, enter a pass phrase to be used as your private key password.
It is recommended your entry be at least eight characters and include numbers
and letters.

NOTE Important – Record your password and store it in a secure location. You cannot use your private key
password or server certificate without it. Once entered, it cannot be recovered.
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3. Generate a certificate signing request:

S At the OpenSSL> prompt, type req -new -key server.key -out server.csr.

S At the pass phrase prompt, enter your private key password.

S Enter information to be incorporated into your certificate request as follows:

Country Name – Two-letter code, such as IT for Italy, GE for Germany, CA for
Canada, US for the United States.

State or Province – Name in full.

Locality – Name of city.

Organization – Name of your company.

Organizational Unit Name – Your department within the company.

Common Name – Network URL or IP address for the server. This is required for
users to access the server.

E-mail Address of the System Administrator

4. Return to the OpenSSL> prompt and exit the Open SSL program.

Just below the “Please enter the following ‘extra’ attributes to be sent with your
certificate request” message, enter a challenge password between the brackets.
When the OpenSSL> prompt appears, quit the program.

5. [Optional] Generate a 30-day self-signed certificate.

S At the OpenSSL> prompt, type req -509 -key server.key -in server.csr -out
server.crt.

S When prompted, enter your private key password.

S Exit the Open SSL utility.

6. Final steps for certification configuration:

S Copy server.key and server.crt to the server certs folder.

S If applying to Verisign or other third-party certification source, copy the
server.csr file to accompany your application.

Configuring HTTPS Server Properties
Access to this function is limited to those with an active PowerVision license. The 30-day
trial license does not support the secure server. See “Licensing PowerVision on page 24 to
register your license key number.

The HTTPS server is a secure server and requires a server certificate and password.

1. On the Admin menu, click HTTPS Server. The HTTPS Server Properties dialog box
opens.

2. On the General tab, you have the following options:

S Enable the HTTPS (Secure) Server – A check in this check box indicates that Web
access is enabled.

To enable or disable the HTTPS server, you must restart the PowerVision
Server.

S Port to Listen on for HTTPS – It is recommended that you accept the default, 443.

S Max Number of Connections

S Refresh Interval
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3. On the Authentication tab, you have the following options:

S User Name – Enables the authentication feature for viewing the HTTPS server.

S Password – Protects access to UPS data.

S Confirm Password

S Enable Acknowledge/Rearm – Allows authorized users to use the Internet to
acknowledge or rearm alarms. Password protection is optional.

NOTE If neither password is set, anyone with Internet access to the computer running the PowerVision
Server software can acknowledge or rearm alarms.

4. On the Connection Keep-Alive tab, you have the following options:

S Max Number of Requests – Specify the Max Number of Requests allowed to web
browsers that support the Keep-Alive function. Keep-Alive maintains
connection with the PowerVision HTTP or HTTPS server when the request for
information is received within the specified Timeout period.

S Timeout – Specify the period (in seconds) for web browsers to submit requests
for HTTP or HTTPS server information before the connection is terminated.

5. On the Appearance tab, you have the following options:

S Border

S Browser Display Format – Browser-based, the default, attempts to determine the
type of browser making the connection and present HTTP or HTTPS server
information in an appropriate format. This setting is useful when multiple
browser types may access the server.

6. On the Certificate tab, type your secure server password as prompted or the
HTTPS server will not read the file.
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Viewing Status Information over the Internet
Once you enable the server for Web service, you can view the server through a web
browser by entering its IP address as the URL or Web address. For example, if the server’s
IP address is 10.222.23.35, you would enter http://10.222.23.35 to access its home page
(see Figure 29).

Figure 29. Home Page (PowerVision Server)

The home page contains navigation buttons with links to the following pages:

S Devices – Displays all devices on the accessed server with color-coded icons showing
status and links to channel information.

S Alarms – Displays all currently active alarms with links to alarm details.

S Reports – Allows reports to be run and retrieved.
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Remote Monitoring by PDA
The PowerVision Server supports remote monitoring by Palm VII and Palm VIIx handheld
wireless PDA devices (see Figure 30).

Figure 30. Personal Digital Assistant

Accessing Data from Your PDA
1. On your Palm VII or Palm VIIx handheld wireless PDA, start your web browser.

2. Enter the server’s IP address as the URL or Web address.
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C H A P T E R 4

WHAT TO DO IN CASE OF ALARM

If at any time one or more system UPSs have an active alarm, PowerVision Server sends
Windows-based alarm notifications to all PowerVision Client users on the network.

Unless you disable alarms (in the System Settings dialog box), when an alarm occurs
anywhere in the system, an alarm sounds and the Alarm Notification dialog box appears
on each PowerVision Client desktop (see Figure 31).

Figure 31. Alarm Notification Dialog Box

Users who are not running the PowerVision Client software do not receive these
notifications. See “Notifying Personnel of Alarms and Alerts” on page 61.

Responding to an Alert Notification
1. Do one of the following:

S Click System Alarms to acknowledge the alarm – See the following section,
“Acknowledging an Alarm.”

S Click System Overview to determine the cause of the alarm – See “Determining
the Cause of an Alarm” on page 48.

S Click Ignore to delay action on the alarm – See “Delaying Action on an Alarm”
on page 49.

2. If prompted, enter a password.

The password requirement is set in the System Settings dialog box by checking
Mandatory password for alarm acknowledgement. See “Changing System Settings”
on page 52.

3. Optionally, or if prompted, enter a note.

The note requirement is set in the System Settings dialog box by checking
Mandatory user note for alarm acknowledgement. On the File menu, click Add Notes
to enter a note when not prompted. To read notes, open the Alarms menu and
click Show Notes.
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Acknowledging an Alarm
1. In the Alarm Notification dialog box, click System Alarms. The Alarm

Management window opens (see Figure 32).

Figure 32. Alarm Management Window with Notes Displayed

2. Select the device that is in alarm.

3. On the Alarms menu (available only with the Alarm Management window), click
one of the following:

S Acknowledge – To change the alarm condition to acknowledged (blue).
Acknowledging alarms silences the audible alert and displays the Add a Note
dialog box (unless disabled in the System Settings dialog box).

S Rearm – To resume testing of the alarm’s acquired value against its set alarm
limits, causing the channel to again report an alarm state if a value exceeds
specified thresholds.

S Ack/Rearm – To acknowledge the alarm and restore alarm limit monitoring to
the chosen channel.

Determining the Cause of an Alarm
In the Alarm Notification dialog box, click System Overview. The System Overview opens.

You have the following options:

S Look at your system – If you want more information about a particular device than the
System Overview provides, double-click the device icon to access the One-line View
where you can examine the device components.

S Review the alarm message – After studying the System Overview, click System Alarms to
open the Alarm Management window, a list of servers with color-coded icons to give
you a quick view of their status. The affected channel, if applicable, and the name of the
alert is provided in the Name column.

S Review a detailed summary – In the Alarm Management window, highlight a device.
Then on the Alarms menu, click Details. The Alarm Information dialog box opens (see
Figure 33).
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Figure 33. Alarm Information Dialog Box

Delaying Action on an Alarm
In the Alarm Notification dialog box, click Ignore to delay action for a period defined in
the Alarm Properties dialog box General tab. See “Changing Alarm Properties” on
page 53.

Accessing Active Alarms on the Web
Before you can access active alarms via the Web, you must enable the HTTP or HTTPS
server.

Enabling the HTTP or HTTPS Server
1. On the PowerVision Server Admin menu, click HTTP Server or HTTPS Server. The

Server Properties dialog box opens.

2. On the General tab, enable the server.

See “Remote Monitoring via the World Wide Web” on page 41.

Enabling Acknowledging and Rearming on the Web
On the Authentication tab of the Server Properties dialog box, select the Enable
Acknowledge/Rearm check box. A password is optional.

See “Remote Monitoring via the World Wide Web” on page 41.

Reviewing and Acknowledging or Rearming Alarms
1. Enable your system as described in the previous section.

2. In a Web browser or Palm VII handheld, enter the IP address for the PowerVision
Server. The PowerVision Server Home page opens.

3. Click Alarms. A list of active alarms opens (see Figure 34).
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Figure 34. PowerVision Web Active Alarms

4. In the Channel column, click a channel. The Alarm Details page opens (see
Figure 35).

Figure 35. PowerVision Web Alarm Details

5. [Optional] Enter a note.

6. Click Acknowledge, Ack and Rearm, or Rearm.
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C H A P T E R 5

CHANGING THE WAY YOUR SYSTEM ISSUES ALARMS

PowerVision is in constant communication with your UPS, receiving information about
the status of power. In the event that power drops below or exceeds certain default levels,
PowerVision is programmed to alert you.

Behind the alert notifications is a comprehensive system of alerts and alert programming.
In PowerVision, we refer to it as alarm management.

With alarm management, you can:

S monitor the number of active alarms in your system by glancing at your Windows
status bar

S monitor alarm information for a device by looking at the Alarm Management window

S monitor alarm information for a channel by accessing the Alarm Information dialog box

S go beyond the default monitoring and manage the way PowerVision alarms work in
your system

This chapter describes how you can manage your alarms, including:

S Changing the way your system notifies you of alarms

S Disabling alarm sounds

S Modifying channel properties

NOTE Channel alarm levels must be defined at the PowerVision Server or the PowerVision Client does not
display them.

NOTE User authorization is required to acknowledge alarms, to rearm alarms, and to access alarm
properties.

NOTE Except for altering channel properties, handle all alarm management and system message
management functions in the PowerVision Client software. Alter channel properties for alarm messages and
priorities in the PowerVision Server software.

NOTE To access the Alarms menu, click SSSSyyyysssstttteeeemmmm AAAAllllaaaarrrrmmmmssss on the PowerVision Client Window menu.
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Changing the Way Your System Notifies You of Alarms
Configure alarm notifications in the System Settings dialog box, by setting properties for
all alarms, and by adjusting the settings for individual channels.

Changing System Settings
1. On the PowerVision Client File menu, point to Administration and click System

Settings. The System Settings dialog box opens (see Figure 36).

Figure 36. System Settings Dialog Box

2. In the System Settings dialog box, you can:

S Require that a password be entered before an alarm can be acknowledged –
Select the Mandatory password for alarm acknowledgement check box.

S Require that a note be entered before an alarm can be acknowledged – Select
the Mandatory user note for alarm acknowledgement check box.

S Disable the Mandatory logon name in alarm note – By default, the user name is
included in all user notes. Clear the Mandatory logon name in alarm note check
box.

S Disable the Enable objects within view to flash function – By default, channel
objects for alarms blink in color to indicate a cautionary (yellow) or critical
(red) situation, an action which could slow system processing. Clear the Enable
objects within view to flash check box.

S Require that the Alarm Management window open automatically if a channel
reports an alarm condition – Select the Display Alarm Management window if
alarm triggered check box.

S Disable the Display System Level Alarm Notification Dialog setting – By
default, the Alarm Notification dialog box appears on your screen whenever a
monitored channel reports an alarm. Clear the Display System Level Alarm
Notification Dialog check box.

To enable a setting, check the box preceding it. Activating the mandatory settings
ensures that all alarm responses are logged through the PowerVision Notes
function, thereby documenting accountability in each instance.
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Changing Alarm Properties
Alarm properties are set on the General, Channels, and Filtering tabs of the Alarm
Properties dialog box. Properties set on the General and Filtering tabs apply to all alarms.
Use the Channels tab to access the Local Channel Properties dialog box.

1. On the PowerVision Client File menu, point to Administration and click Alarm
Properties. The Alarm Properties dialog box opens (see Figure 37).

Figure 37. Alarm Properties Dialog Box

2. Use the Alarm Properties dialog box to define how PowerVision responds to
detected alarms. Adjustments you can make are as follows:

S General tab – Set the number of views displayed when alarms are reported, set a
sort order for alarms, set a period for ignoring alarms, and disable alarm
sounds.

S Channels tab – Select a meters or status channel and click Edit. In the Local
Channel Properties dialog box, write your own description of the channel,
write text messages to be displayed at the critical or cautionary alarm level, and
change the default beep sound.

S Filtering tab – Control the alarm messages you receive by channel and server.

Disabling Alarm Sounds
On the Alarms menu, click Silence.

Modifying Channel Properties
When you install the PowerVision Server and PowerVision Client software, the programs
automatically identify all channels the UPS supports. By default, the programs include
descriptions of each channel and various other properties including delays. These
properties are meant to cover most situations. While it is possible to modify channel
properties in the Status Channel Properties dialog box and the Meters Channel Properties
dialog box, you are advised to do so only with caution.



Changing the Way Your System Issues Alarms

54 PowerVision® Software User’s Guide S Rev A www.powerware.com

Access the Channel Properties dialog box in one of the following ways:

S On the Status View or Meters View, select a channel and click Channel Properties.

S On the PowerVision Client Edit menu, click Find Channel. In the Find Channel dialog
box select a channel and click Properties.

S In the PowerVision Server software as follows:

1. In the Devices window, select a device.

2. On the Admin menu, click End Database Session.

3. On the Admin menu, click Start Server Config.

4. Expand the listing for the desired device.

5. Highlight a status channel or a meters channel.

6. On the Edit menu, click Properties. The Status Channel Properties dialog box or
the Meters Channel Properties dialog box opens.

7. Modify the channel.

8. Close the dialog box.

9. On the Admin menu, click End Server Config.

10. Click Properties.

The Status Channel Properties dialog box and the Meters Channel Properties dialog box
each have a General tab, a Basic tab, and an Advanced tab. The following sections explain
adjustments you can make through the Channel Properties dialog box:

S Changing the Description and Disabling or Disarming the Channel

S Defining and Activating Alarm Thresholds and Priority

S Setting Alarm Delays and Thresholds

NOTE Use the Copy Channel Properties and Paste Channel Properties options on the Edit menu to speed
your reconfiguration of channel properties. After configuring properties for one channel, click CCCCooooppppyyyy
CCCChhhhaaaannnnnnnneeeellll PPPPrrrrooooppppeeeerrrrttttiiiieeeessss. Then open the properties dialog box for a second channel and click PPPPaaaasssstttteeee CCCChhhhaaaannnnnnnneeeellll
PPPPrrrrooooppppeeeerrrrttttiiiieeeessss.

Changing Channel Descriptions – Disabling and Disarming Channels
Use the General tab of the Channel Properties dialog box to change the channel
description and to disable or disarm the channel. For meters channels, you can specify a
unit of measure and an archiving method. For status channels, you can specify a true
string and a false string.
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The Meters Channel Properties General tab is shown in Figure 38.

Figure 38. Meters Channel Properties General Tab

Properties you can change on the General tab are:

S Description – Enter a description of the channel, if desired, to more easily identify it.

S Units – Enter the desired display units for this channel’s readings. The units are
reported in conjunction with the channel’s current value.

S Archive – Specify an archive method for storing this channel’s data on the PowerVision
server database. It may be the AVERAGE value reported, or the MINIMUM,
MAXIMUM, FIRST, or LAST reading over the archive interval for this channel.

S Channel Disabled – When checked, data is not archived for this channel to the
PowerVision Server. Disabling a channel is useful when making repairs to avoid
archiving inappropriate readings.

S Channel Disarmed – When checked, suspends alarm limit testing as specified in this
channel’s Basic Properties dialog box. Data, however, continues to be archived.
Disarming a channel is useful when making repairs to avoid reporting nuisance alarms.

Properties you cannot change are:

S Channel State – A fixed entry reporting current alarm status of the input such as
Normal, Cautionary, Critical, or Acknowledged.

S Current Value – A fixed entry showing the channel’s last reported reading.
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The Status Channel Properties General tab is shown in Figure 39.

Figure 39. Status Channel Properties General Tab

Properties you can change are:

S Description – Enter a description of the channel, if desired, to more easily identify it.

S True String – The operational state reported for this channel when its current value is
TRUE.

S False String – The operational state reported for this channel when its current value is
FALSE.

S Channel Disabled – When checked, data is not archived for this channel to the
PowerVision Server. Disabling a channel is useful when making repairs to avoid
archiving inappropriate readings.

S Channel Disarmed – When checked, suspends alarm limit testing as specified in this
channel’s Basic Properties dialog box. Data, however, continues to be archived.
Disarming a channel is useful when making repairs to avoid reporting nuisance alarms.

Properties you cannot change are:

S Channel State – A fixed entry reporting current alarm status of the input as Normal,
Cautionary, Critical or Acknowledged.

S Current Value – A fixed entry showing the channel’s last reported reading.

Defining and Activating Alarm Thresholds and Priorities
Use the Basic tab of the Channel Properties dialog box to define and activate the channel’s
alarm thresholds, associated messages, and relative importance. For meters channels, you
can set high and low limits for high and low critical and cautionary alarm states. For
status channels, you can enable the alarm, specify whether it is triggered by a true or false
value, and specify whether the reported alarm is cautionary or critical.
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The Meters Channel Properties Basic tab is shown in Figure 40.

Figure 40. Meters Channel Properties Basic Tab

Properties you can change are:

S Enable Hi and Lo Critical, Hi and Lo Caution and Limits – Select Hi or Lo to activate
monitoring of the channel’s critical (red) limits and/or cautionary (yellow). Default
settings could result in multiple alarms for a single event, especially between analog and
digital points for a particular device. If these standard settings are determined to be
excessive or redundant, you can disable the appropriate cautionary or critical alarm,
adjust its corresponding threshold limit, or create a filter at the client to screen out
inconsequential or nuisance alarms.

S Alarm message – Messages may be independently assigned to the Hi and Lo Limits to
appear in conjunction with the alarm condition whenever it is reported.

S Priority – Assign the channel an alarm priority (1 = highest, 9999 = lowest). Whenever
any of its assigned limits is exceeded, the channel can be listed in the PowerVision
Client Alarm Management dialog box based on its relative priority.

The Status Channel Properties Basic tab is shown in Figure 41.

Figure 41. Status Channel Properties Basic Tab
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Properties you can change are:

S Enable Alarm – Activates monitoring of a meters (analog) channel’s cautionary (yellow)
and critical (red) alarm limits. A status (digital) channel is either enabled or disabled.

S Alarm Message – The display text corresponding to the channel’s cautionary (yellow)
and critical (red) alarm limits, if enabled. Messages may be independently assigned to
the hi and lo limits for each meters (analog) channel level excursion. A status (digital)
channel can have only one message.

S Alarm on Value – Specifies whether a false (0) or a true (1) value triggers an alarm for
this channel.

S Alarm Type – Specifies whether an alarm reported on this channel represents a
cautionary (yellow) or a critical (red) alarm limit excursion.

S Priority – Assign the channel an alarm priority (1=highest, 9999=lowest).

Setting Alarm Delays and Thresholds
Use the Advanced tab of the Channel Properties dialog box to enable and define delays for
Ack Holdoff, Re-Arm, and Delay Alarm, and also to enable latching. On meters channels,
you can also enable and define values for hysteresis and scaling.

All detected alarms are available through the PowerVision Client Alarm History reports.

The Meters Channel Properties Advanced tab is shown in Figure 42.

Figure 42. Meters Channel Properties Advanced Tab

Properties you can change are:

S Enable Ack Holdoff – The delay after a channel alarm has been acknowledged (or
silenced) before it is again rearmed, in seconds. Acquired data continues to be displayed
during the holdoff period, but the channel’s current value is no longer compared to its
defined alarm limits. The default holdoff of one hour may be manually overridden at
any time using the client’s Rearm command, or when the alarm is acknowledged by a
PowerVision Client.

S Enable Re-Arm – The period of time (in seconds) before alarm monitoring is
automatically restored to a disabled channel. Rearming a channel manually resumes
testing of its acquired current value against its enabled alarm limits.

S Enable Delay Alarm – The period of time (in seconds) before an alarm detected on this
channel is reported. The default is to report alarms immediately.
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S Alarm Latching – With latching disabled (the default), the PowerVision Client software
automatically removes the channel from the active alarm list if its value returns to
within specification, thereby minimizing the reporting of minor or nuisance alarms.
This approach could result in missed alarms on channels that are experiencing
momentary excursions. Enable latching to continue to report the channel’s alarm state
(even if its current value returns to within specification) until the condition is
acknowledged. Note that the alarms must be enabled and limits assigned under the
Basic tab in the Meters Channel Properties dialog box.

S Hysteresis – The threshold above and below which a new alarm is reported. Hysteresis
is used to eliminate nuisance alarms when an channel’s input is near its alarm limit.
Once an alarm occurs, the input level must drop below or rise above the threshold
value specified in the channel’s display units (such as volts, amps, Hz, kVA, kw, or
other), then exceed the limit once again before a new alarm is reported for the channel.
Note that this attribute is only available for non-latching alarms.

S Enable Scaling – When active, allows you to apply a linear scaling factor to the channel’s
minimum and maximum raw and scaled values. Only integer values are acceptable
entries.

The Status Channel Properties Advanced tab is shown in Figure 43.

Figure 43. Status Channel Properties Advanced Tab

Properties you can change are:

S Enable Ack Holdoff – The delay after a channel alarm has been acknowledged (or
silenced) before it is again rearmed, in seconds. Acquired data continue to be displayed
during the holdoff period, but the channel’s current value is no longer compared to its
defined alarm value. The default holdoff of one hour may be manually overridden at
any time using the PowerVision Client’s Rearm command, or when the alarm is
acknowledged by a PowerVision Client.

S Enable Re-Arm – The period of time before alarm monitoring is automatically restored to
a disabled channel, (also in seconds). Rearming a channel manually resumes testing of
its acquired current value against its enabled alarm limits.

S Enable Delay Alarm – The period of time (in seconds) before an alarm detected on this
channel is reported. The default is to report alarms immediately.
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S Enable Latching – A toggle state which determines whether an alarm condition
continues to be reported if the channel’s current value returns to within its assigned
critical or cautionary alarm limits. When enabled, the channel’s highest alarm state is
reported regardless of its current value and remains so until acknowledged by a client.
When disabled, a channel is automatically removed from the Status bar’s active alarm
totals if its value returns to within its specified limits. The alarm also must be enabled
under the Basic tab in the Status Channel Properties dialog box.

PowerVision is shipped with latching disabled, which automatically removes the
channel from the active alarm list if its value returns to within specification, thereby
minimizing the reporting of minor or nuisance alarms. This approach could, however,
result in missed alarms on channels that are experiencing momentary excursions.
Enable latching to continue to report the channel’s alarm state (even if its current value
returns to within specification) until the condition is acknowledged by a PowerVision
Client. The alarm also must be enabled under the Basic tab in the Status Channel
Properties dialog box.

All detected alarms are available through the PowerVision Client’s Alarm History reports.
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C H A P T E R 6

NOTIFYING PERSONNEL OF ALARMS AND ALERTS
Use the Message Management dialog box to configure alert notification. PowerVision
alerts personnel by page, e-mail, or other means in response to individual alert conditions.

You can open the Message Management window from the Window menu of either the
PowerVision Server or the PowerVision Client software.

NOTE To access the Message Management dialog box from the PowerVision Server software, you must
first end your database session from the Admin menu and click Start Server Config.

NOTE If you are opening the Message Management window for the first time, you must open the Message
Management dialog box. To do this, position your mouse pointer in the gray area of the toolbar and slowly
bring it down toward the center of the screen until it changes shape. Then, click and drag downward,
displaying the Message Management dialog box. Thereafter, the Message Management window and
Message Management dialog box open together (see Figure 44).

Figure 44. Message Management Dialog Box and Message Management Window
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Alerting Offsite Personnel
1. On the PowerVision Client Window menu or the PowerVision Server (with Server

Config started) Window menu, click Message Management.

The Message Management window opens.

2. Configure alert notification by setting details on the tabs of the Message
Management dialog box in the following order:

S Step 1. Modems – If your system uses a modem for communication, configure it
here. Do this first, then click Services. See “Step 1. Configuring Modems” on
page 63. If you do not use a modem, go to the Services tab.

S Step 2. Services – Configure the notification services you want, including page,
messaging mail, printer, COM port, and e-mail. See “Step 2. Configuring
Services” on page 64.

S Step 3. Subscribers – Configure subscribers or offsite personnel to receive
messages. See “Step 3a. Configuring New Subscribers” on page 66 or “Step 3b.
Reconfiguring Existing Subscribers” on page 67.

S Step 4. Notification Lists – Determine the sequence and timing of alerts. See
“Step 4a. Reconfiguring an Existing Notification List” on page 68, “Step 4b.
Configuring a New Notification List” on page 69, and “Step 4c. Testing Your
Notification Configuration” on page 69.

S Step 5. Channel Message Settings – Determine what alarm states (critical,
caution, acknowledge, or normal) for a given device prompt messages to
recipients. See “Step 5. Configuring Channel Message Settings” on page 70.

S Step 6. Server Offline Messaging – Identify the personnel who are notified if the
connections with the server are lost by this subscribing client, and specify the
message to be forwarded and conditions for terminating the call. It is
recommended that you maintain a specific Notification List to ensure that
someone responds to a Server Offline condition. See “Step 6. Configuring
Server Offline Messaging” on page 71.

S Step 7. System Alarms Messaging – Identifies those who are notified if the server
is not archiving data or its available hard disk space is below the capacity
specified in its Properties dialog box, and the message to be forwarded. It is
recommended that you maintain a specific Notification List to ensure that
someone responds to a System Alarm condition. See “Step 7. Configuring
System Alarms Messaging” on page 72.
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Step 1. Configuring Modems
This step is only for systems using modems for communication. If your system does not
use a modem, go to “Step 2. Configuring New and Existing Services” on page 64.

1. On the Modems tab of the Message Management window, click New. The Modem
Properties dialog box opens (see Figure 45).

Figure 45. Modem Properties Dialog Box

2. Enter a name for a modem, the connection settings, the initialization string, and
the dial string.

Modem Name – Identifies the modem to be used for PowerVision Client Message
Management.

Modem Init String – Any special interface characters required by the modem
connection. Typically this setting remains blank (null). If the pager does not
respond with an OK, see its operation manual to determine a Modem Init String
(with a maximum of 80 characters) that works properly.

Modem Dial String – Any special characters required by the telephone connection,
such as a dialing prefix (9) to obtain an outside communication line.

NOTE To reconfigure an existing modem, select the modem name, and click Properties on the Modems
tab of the Message Management dialog box. The Modem Properties dialog box opens. Make any necessary
changes.
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Step 2. Configuring Services
Supported services include alpha page, numeric page, Windows messaging mail, printing,
output to COM port, and SMTP mail. Configure new services and reconfigure existing
services on the Services tab of the Message Management window (see Figure 46).

Figure 46. Message Management Window Services Tab
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1. On the Services tab of the Message Management window, click New and click on
one of the following:

S Alpha Page – To configure a connection to an alpha or alphanumeric paging
service. Opens the Alpha Paging Service Properties dialog box.

S Numeric Page – To configure a connection to a numeric paging service. Opens
the Numeric Service Properties dialog box.

S Windows Messaging Mail – To configure a Windows message. Opens the Mail
Service Properties dialog box.

S Printer – To configure a printed record. Opens the Printer Service Properties
dialog box.

S Output to COM Port – To configure a message to a device attached to a COM
port. Opens the COM Port Service Properties dialog box.

S SMTP Mail – To configure an e-mail message. Opens the SMTP Mail Service
Properties dialog box.

2. Configure the service.

S Alpha Page – In the Alpha Paging Service Properties dialog box, enter a service
name and properties.

S Numeric Page – In the Numeric Service Properties dialog box, enter a service
name, properties, and (optional) a delay.

S Windows Messaging Mail – In the Mail Service Properties dialog box, enter a
service name, the message subject, and sent message options.

S Printer – In the Printer Service Properties dialog box, enter a service name,
printer, and printing properties.

S Output to COM Port – In the COM Port Service Properties dialog box, enter a
service name and COM Port.

S SMTP Mail – In the SMTP Mail Service Properties dialog box, enter a name for
the service, a message subject, the IP address or name of your mail server, and
the e-mail address of the sending client.

NOTE To reconfigure an existing service, select it on the Services tab and click Properties. The
appropriate properties dialog box opens.
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Step 3a. Configuring New Subscribers
This is the procedure for configuring new subscribers. To reconfigure an existing
subscriber, see “Reconfiguring Existing Subscribers” on page 67.

NOTE Subscribers who are to be notified by multiple services must be configured for each service. Hence,
if subscriber John Doe was to be notified by page and e-mail, you should create separate subscribers such
as John Doe Page and John Doe Mail.

1. On the Subscribers tab of the Message Management window, click New. The
Subscriber Properties dialog box opens (see Figure 47).

Figure 47. Subscriber Properties Dialog Box

2. Enter a subscriber name in the Subscriber Name area.

3. In the Availability area, click New. The Available Time Properties for [Subscriber]
dialog box opens (see Figure 48).

Figure 48. Available Time Properties for [Subscriber] Dialog Box

4. Enter the hours and days the subscriber is available.
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5. In the Service Information area, select a service for the subscriber. To configure a
service, see “Configuring a Service” on page 64.

6. Enter the requested service information which varies depending on the service
selected.

Step 3b. Reconfiguring Existing Subscribers
1. On the Subscribers tab of the Message Management window select the subscriber

and click Properties. The Subscriber Properties dialog box opens (see Figure 49).

Figure 49. Subscriber Properties Dialog Box (Existing Subscriber)

2. Select a Time-Date entry and click Properties. The Available Time Properties for
[Subscriber Service] dialog box opens (see Figure 50).

Figure 50. Available Time Properties for [Subscriber Service] Dialog Box

3. Edit as necessary.
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Step 4a. Reconfiguring an Existing Notification List
1. On the Notification Lists tab of the Message Management dialog box, highlight an

existing notification list.

Figure 51. Notification Lists Tab with List Highlighted

2. Click Properties. The Notification List Properties dialog box opens (see
Figure 52).

Figure 52. Notification List Properties Dialog Box (General Tab)
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3. Perform any of the following tasks on the General tab:

S Change the time to wait before calling – Select a subscriber name and click
Properties, opening the Subscriber Call Delay dialog box.

S Add a subscriber – Click Add, opening the Subscribers dialog box with a list of
subscribers entered at the Subscribers tab. See “Configuring New Subscribers”
on page 66.

S Remove a subscriber – Select a subscriber name and click Remove.

S Select the Advanced Tab – Click Advanced to open the Advanced Tab (see
Figure 53).

Figure 53. Notification List Properties Dialog Box (Advanced Tab)

4. Enter settings for frequency of calls, delays, and call properties.

Step 4b. Configuring a New Notification List
1. On the Notification Lists tab of the Message Management dialog box, click New.

The Notification List Properties dialog box opens (see Figure 52).

2. On the General tab of the Notification List Properties dialog box, enter a name for
a group (for example, day shift, night shift, sys admin A).

3. Click Add to add subscribers to the list. The Subscribers dialog box opens with a
list of subscribers entered at the Subscribers tab. See “Configuring New
Subscribers” on page 66.

4. On the Advanced tab of the Notification List Properties dialog box (see
Figure 53), specify frequency of calls, delays, and call properties.

Step 4c. Testing Your Notification Configuration
1. On the Notification Lists tab of the Message Management dialog box, select a

notification list.

2. Click Test Call.
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Step 5. Configuring Channel Message Settings
You must now assign the Notification List or lists to be notified in case of an alert on each
server channel.

1. Open the Channel Message Settings tab of the Message Management dialog box
(see Figure 54).

Figure 54. Channel Message Settings Tab

Data on this tab is arranged in columns headed Server, Device, Name, Notify List
Critical, Notify List Caution, Notify List Acknowledge, and Notify List Normal.
To facilitate working on channel settings, you can click any of these headings to
rearrange the list. Hence, clicking Server arranges all listings by server, and so on.

2. Arrange the channels according to server, device, or name, and select the channels
you wish to configure. To select multiple channels, hold down the CTRL key and
select.

3. Click Edit. The Channel Message Settings dialog box opens (see
Figure 55).
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Figure 55. Channel Message Settings Dialog Box

If you selected multiple channels, select the Enable Edits for Multiple Entries check
box at the bottom of the Channel Message Settings dialog box.

4. On any tab of the Channel Message Settings dialog box, perform the following
tasks:

S In the Notification List area, select the list to be notified.

S In the Numeric area (if available), enter text for a message.

S In the Alpha area (if available), select either Standard Message or Custom
Message. If you select Standard Message, you can select the appropriate check
boxes to include the server name, device name, channel name, your special
text, or the standard alarm message.

S In the Copy these settings to other dialog tabs area, if desired, click the
appropriate button to copy your settings to another tab.

Step 6. Configuring Server Offline Messaging
Server Offline Messaging does the following:

S Identifies those who are notified if the subscribing client loses connections with the
server.

S Specifies the message to be forwarded.

S Specifies the conditions for terminating the call.

It is recommended that you maintain a specific Notification List to ensure that someone
responds to a Server Offline condition.

1. On the Server Offline Messaging tab of the Message Management dialog box,
select the Critical tab, Acknowledge tab, or the Normal tab.

2. Select a Notification List.

To review properties for a list, click Show List.
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3. If your list requires a numeric paging service, enter the message to be sent. If an
alpha paging service is required, select the standard message or create a custom
message.

4. Copy these settings to the remaining two tabs, or click another tab and Steps 1
through 3.

Step 7. Configuring System Alarms Messaging
System Alarms Messaging reacts when system channel values reach a cautionary or critical
state, or when they return to normal or are acknowledged.

To review or reconfigure system channel values, in the PowerVision Server Devices
window, expand the System Channel list and select and access the properties of one of the
following: Active Client Connections, Configuration Backup, Database Archiving,
Database Backup, Database Status, Disk Free Space, System Alarm.

It is recommended that you maintain a specific Notification List to ensure that someone
responds to a System Alarm condition.

1. On the System Alarm Messaging tab of the Message Management dialog box,
select the Critical tab, Acknowledge tab, or the Normal tab.

2. Select a Notification List.

To review properties for a list, click Show List.

3. If your list requires a numeric paging service, enter the message to be sent. If an
alpha paging service is required, select the standard message or create a custom
message.

4. Copy these settings to the remaining two tabs, or click another tab and Steps 1
through 3.
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C H A P T E R 7

GRAPHING YOUR DATA
This chapter includes the following sections:

S Creating a simple graph

S Optional changes and enhancements

S About PowerVision’s graph styles

S Using PowerVision’s graphs to see data

PowerVision’s graphing tools, accessed in the PowerVision Client software, use the meter
(analog) channel and status (digital) channel data archived in PowerVision Server to bring
you an array of display options, including:

S Standard graphs – The classic graph with 10 style options showing X-axis, Y-axis, and
optional right Y-axis and plots of up to 20 channels over times from 1 hour to
6 months. You can create and save the graph framework and the current reference to
the data in the PowerVision Server software, or you can choose to save just the graph
framework so it is updated each time you re-open PowerVision Server and PowerVision
Client. See “Creating a Simple Graph” on page 74.

S Burst graphs – A moving, real-time graph of a single channel with scrolling X-axis so
you can see data as it develops. See “Create a Burst Graph” on page 80.

S Projection graphs – ProGraph projection graphs give you the power to plot a channel’s
future trend based on archived data, with the single push of a button. See “Create a
Projection Graph” on page 80.

S Single point analysis – A secondary window opens showing each trace, the unit, and the
average value for each graphed channel. See “Point Analysis” on page 80.

S Range analysis – A secondary window opens showing summary details for each graphed
channel including minimum, maximum, range, delta, mean, median, standard
deviation, and trend. See “Range Analysis” on page 80.

You can print your graphs and/or save them as files for future reference. You can paste
your trace data into a word processor or spreadsheet program, and you can paste your
graphs into a word processor or presentation program. See “Optional Changes and
Enhancements” on page 80.

A channel’s data are quickly plotted and you can adjust graph properties to meet a variety
of display requirements. As many as 20 meters channel or status channel traces (and left
and right Y-axes) can be viewed per graph and the data copied to a spreadsheet, a feature
which can be extremely helpful in researching a cause-and-effect relationship or
comparing the performance of one device to another.

Besides providing a quick visual representation of existing channel trends, the graph
function accesses your notes associated with their server(s). Use notes as an aid in system
analysis by supplementing the actual data with your timely observations.

NOTE The graph display takes into account the client/server Time Differential setting on the Advanced tab
of the Server Properties dialog box. Thus, a computer running the PowerVision Server software with a Time
Differential offset of “-2” would present a graph spanning two hours less than the current time of a
computer running the PowerVision Client software.
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Creating a Simple Graph
The following procedure is for creating a graph showing input voltage for phase A/B and
input current for phase A on a server for a 24-hour period.

It is recommended that you start the graphing process from the Meters View. To access
the Meters View, open the System Overview (the default) of the PowerVision Client
software and double-click the icon for the server with the channels you want to graph.
This opens the One-line View for the server. In the Navigation Panel of the One-line View,
click Meters View.

NOTE You can create a standard graph from stored data only. You can create a graph from the Edit menu or
the File menu. You can open a saved graph from the File menu by clicking OOOOppppeeeennnn.

1. Create a graph. In the Meters View, right-click M\Input Voltage Phase A/B, opening
a contextual menu. Click Graph. The graph opens.

Figure 56. Graph of M\Input Voltage Phase A/B Channel Data Before Changes

The Graph menu and Graph toolbar appear on your screen. A contextual graph
menu is available when you right-click the graph. The following steps reference
the Graph menu but users can access the same controls from the Graph toolbar or
the contextual menu.

2. Add the channel M\Input Current Phase A. On the Graph menu, click Add
Channel and in the Select a Channel dialog box select M\Input Current Phase A,
adding a trace for this channel to your graph (see Figure 57).
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Figure 57. Graph with M\Input Current Phase A Added (Step 2)

NOTE Comparing Figure 56 with Figure 57 shows that the left or Y-axis scale has changed. This is because
the input current value range is significantly less than the input voltage range, and both traces are attached
to the left Y-axis. We adjust for this in Step 10.

3. Save the graph to a file. On the File menu, click Save As to save the graph file as
Mygraph. Extensions are .fxg for standard graphs, .fxb for burst graphs, and .fxp
for projection graphs. You can save the X-axis information with the following
choices:

S Last 24 hours – When the file is closed and re-opened, the data for the previous
day is plotted.

S Specified time settings – When the file is closed and re-opened, the graph is
restored as currently displayed.

S Specified time range – When the file is closed and re-opened, the current
time-span of the graph is retained as set on the Date/Time tab of the Graph
Properties dialog box.

NOTE Always save your work as you work on your graph. You are not prompted to save before closing. If
you close your graph without saving, all work is lost.

4. Add a Note explaining the significance of the graph. On the File menu, click Add
Note, enter the text Something unusual is going on this morning, and click OK.
You are limited to a note of 295 characters. In the upper right corner of your
graph, click the X control to close the graph. On the File menu, click Open and in
the Open dialog box select your graph. On the Graph menu, click Show Notes.
The Notes box appears at the bottom of your screen below the legend. It may be
necessary for you to drag the bottom border of the graph downward to display
your note.

Notes are maintained by date, defaulting to the current date.
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5. Hide and show the legend. On the Graph menu, select the Show Legend check box
(the default). Clearing the Show Legend check box hides the legend.

6. Adjust the general properties. On the Graph menu, click Properties, opening the
General tab of the Graph Properties dialog box where you can make the following
adjustments:

S Window Title – The default is the system filename. When saved, it is printed on
the title bar for the graph. You can change the window title for the current edit
session, but it is not saved.

S Description – This is your private note regarding the graph. Type Something
really unusual happened today.

S Style – Accept Line, the default. See “PowerVision’s Graph Styles” on page 81.

S Background – For a printed graph, select white.

S Graph Title – Type Input Voltage Phase A/B vs. Input Current Phase A, 12-13
August and click Font. In the Font dialog box, change the font to Arial, the size
to 10, and the font style to bold.

S Check Boxes – The Show Legend check box is selected by default; all other
check boxes are cleared.

Figure 58. Graph After Changes in Step 6

7. Set the cautionary and critical alarm limits for the Input Voltage channel. On the
Window menu, click the option for the server’s meters channel, opening the
Meters View. Right-click M\Input Voltage Phase A/B, then click Channel Properties.
The Channel Properties dialog box opens. On the Basic tab, enter values for the Hi
and Lo Critical and Cautionary limits and select the check boxes. For example, for
Hi Critical enter a limit of 503. For Lo Critical enter 488. For Hi Caution enter
500 and for Lo Caution enter 492.
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NOTE With the settings in Step 7, you receive an alarm message any time your system reaches these
levels. To disable the alarms, return to the Channel Properties dialog box and clear the check boxes or set
the alarm limits out of range.

8. Adjust the traces, activate the alarm limits display, and set the left Y-axis for Input
Voltage. On the Window menu, click MyGraph.fxg to return to your graph. On the
Traces tab of the Graph Properties dialog box, select the M\Input Voltage Phase A/B
trace and make the following adjustments:

S Legend – The Text field shows the channel name for the trace. Click Font and
change the font size to 6 and the font style to bold.

S Color – Select another color for the trace, if desired.

S Pattern – Accept Solid, the default.

S Width – Change to 2.

S Axis – Click Left to display Input Voltage on the left axis.

S Alarm Limits – Select the Cautionary and Critical check boxes. Having defined
your critical and cautionary alarm limits in the Channel Properties dialog box
(Step 7), when you select the Show Limits check box on the Graph menu, the
alarm limits for Input Voltage are displayed.

9. Show alarm limits. On the Graph menu, select the Show Limits check box.
Assuming you followed the procedures in Step 7 and Step 8, red lines for critical
and yellow lines for caution appear on your graph. To facilitate on-screen viewing
of the yellow caution line, return to the General tab of the Graph Properties
dialog box and change the background to a contrasting color such as gray.

10. Adjust the traces and set the right Y-axis for Input Current. On the Traces tab of
the Graph Properties dialog box, select the M\Input Current Phase A trace and make
the following adjustments:

S Legend – The Text field shows the channel name for the trace. Because you
edited the legend text font properties in the M\Input Voltage Phase A/B trace,
the same change is applied to the M/Input Current Phase A trace.

S Color – The system defaults to a different color for each trace. Select another
color for the trace, if desired.

S Pattern – Select Dot.

S Width – This option is not available with the Dot pattern.

S Axis – Click Right to display Input Current on the right axis.

S Alarm Limits – If you set cautionary and critical alarm limits on the Channel
Properties dialog box for M\Input Current Phase A, select the Cautionary and/or
Critical check boxes.

When you click OK to close the Graph Properties dialog box, your graph appears
as shown in Figure 59.
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Figure 59. Graph After Changes in Step 10

11. Reconfigure the X-axis. On the X Axis tab of the Graph Properties dialog box,
make the following adjustments:

S Title Attributes – Accept the default (Major = 1 hour, Minor = 10 minutes) or
change the title, its color, and the font.

S Tick Intervals – These values cannot be changed.

S Save X axis information as – Choose one of the following:

- The last 24 hours – Plots the previous day’s data when the file is reopened.

- The current settings specified – Restores the graph as currently displayed.

- The specified time span – Retains the range of the graph and recreates it when
it is reopened. For instance, if the graphed interval is one week, the next
time the saved graph is opened it displays data for the preceding week.

S Show Grid Lines – Selecting this check box adds vertical grid lines to your
graph.

12. Adjust the left axis. On the Left Axis tab of the Graph Properties dialog box, make
the following adjustments:

S Title – Type Input Voltage Phase A/B. When you close the Graph Properties
dialog box, the title appears along the left axis of your graph. Click Fonts and
change the font to Arial, the size to 8, and the style to bold.

S Color – Changes the display color of the Input Voltage trace and legend
information.

S Show Grid Lines – Selecting this check box adds horizontal grid lines to your
graph from left to right.

S Value – The Autoscale data default automatically inserts an appropriate scale
for the selected trace for this axis, or you can clear the Autoscale data
checkpoint and enter your own values.
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13. Adjust the right axis. On the Right Axis tab of the Graph Properties dialog box,
make the following adjustments:

S Title – Type Input Current Phase A. When you close the Graph Properties
dialog box, the title appears along the right axis of your graph. Click Fonts and
change the font to Arial, the size to 8, and the style to bold.

S Color – Changes the display color of the Input Current trace and legend
information.

S Show Grid Lines – Selecting this check box adds horizontal grid lines to your
graph from right to left.

S Value – The Autoscale data default automatically inserts an appropriate scale
for the selected trace for this axis, or you can clear the Autoscale data
checkpoint and enter your own values.

14. Adjust the time period covered by the graph. On the Date/Time tab of the Graph
Properties dialog box, make the following adjustments:

S Start Date – Select the month and year for the start of the graph, changing the
calendar. On the calendar, click the start date.

S Start Time – Select the hour (up to 24) and minutes (up to 59).

S End Date – Select the month and year for the end of the graph, changing the
calendar. On the calendar, click the start date.

S End Time – Select the hour (up to 24) and minutes (up to 59).

Current Settings shows the start and end time and the range (see Figure 60).

Figure 60. Completed Graph
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Optional Changes and Enhancements

Zoom Out and Zoom In
On the Graph menu, click Zoom Out to expand your graph to cover up to six months, or
Zoom In to narrow your focus to as small an area as one minute.

Point Analysis
On the Graph menu, click Analysis and point to Single Point. A secondary window opens
showing each trace, the unit, and the average value. On the Edit menu, click Copy Analysis
Data and paste into a word processor or spreadsheet program (see Figure 61).

Figure 61. Point Analysis

Range Analysis
On the Graph menu, click Analysis and point to Range. A secondary window opens
showing summary details for each graphed channel including minimum, maximum,
range, delta, mean, median, standard deviation, and trend. On the Edit menu, click Copy
Analysis Data and paste into a word processor or spreadsheet program (see Figure 62).

Figure 62. Range Analysis

Create a Burst Graph
On the File menu, click New and Burst Graph, then select a channel. A graph opens with
the X-axis at the present minute. Plots are added each second in real time. Edit the
properties of the graph, and save and print it, as desired.

Create a Projection Graph
Create a new graph with a single data channel. On the Graph menu, click Projection. The
display changes to the second half of the original display with the second half,
representing the future, blank. A blue line crosses your screen representing the projection
of the trend of your current data to the future. Edit the properties of the graph, and save
and print it, as desired.
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Print the Graph
On the Print menu, click Print. The Print Parameters dialog box opens with the following
choices:

S Graph Window Background – Prints graph with clear background.

S Plot Area Background – Prints graph with solid background.

S Print Border Around Graph – Prints graph with border around entire page.

S Print Graph to Maximum Size – Prints graph approximately 8 inches wide in portrait
mode or 10.5 inches wide in landscape mode.

S Print Graph Proportionate
S Print Graph Exact Size – Prints graph approximately 5.25 inches by 2.5 inches.

Paste the Graph Information into a Spreadsheet Program
On the Edit menu, click Copy Trace Data. In the spreadsheet program, paste into a
spreadsheet. The information is added, if the program supports it.

Paste the Graph into a Presentation Program
On the Edit menu, click Copy Graph. In the presentation program, paste into a screen. The
information is added, if the program supports it.

PowerVision’s Graph Styles
Figure 63 through Figure 72 show PowerVision’s graph style options.

Figure 63. 3D Bar Style Graph
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Figure 64. Area Style Graph

Figure 65. Bar Style Graph
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Figure 66. Deep Bar Style Graph

Figure 67. Group Bar Style Graph
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Figure 68. Line Style Graph

Figure 69. Line with Marker Style Graph
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Figure 70. Scattered Style Graph

Figure 71. Stacked Bar Style Graph
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Figure 72. Stacked Line Style Graph

Things to Remember About PowerVision Graphs
S If the PowerVision Server software wasn’t running over a certain period, you cannot

create a standard graph or a projection graph for the period.

S To keep the framework for your graph, you must save it. You have the option to save
your graph with the data that is present at the time you save, or to save only the
framework for your graph (the default) so that when you reopen it you reopen the most
current data.

Using PowerVision Graphs to Analyze and Report Data
This section describes several practical situations and how the PowerVision graph
function could be used as the solution.

Maintaining Records of Server History
Situation: You are asked to keep a week-by-week record of the input and output power,
input and output frequency, and battery runtime.

Solution:

1. Create a graph. At the PowerVision Client System Overview, double-click the icon
for ABCserver. The One-line View opens.

2. In the Navigation Panel of the One-line View, click Meters View. The Meters View
opens.

3. On the Meters View, right-click a channel for your graph (input voltage and
output voltage for phase A/B, input and output frequency, or battery runtime).
A contextual menu opens.

4. Click Graph. The graph opens for the selected channel.

5. Add additional channels as necessary. On the Graph menu, click Add Channel.
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6. Title your graph. On the Graph menu, click Properties. In the Graph Properties
dialog box, type a title.

7. Save the graph. On the PowerVision Client File menu, click Save As. Assign a
filename and Save. Now you can open the graph in the PowerVision Client
software.

Screen Capture Option: Save the graph in a screen capture program and insert it
into a word processing program document. See your word processing program
documentation for information regarding file types.

Print (Hard Copy) Option: On the File menu, click Print. The Print Options
dialog box opens, allowing you to adjust your graph. When you click OK, the
Print dialog box opens. Suggestion: If printing a horizontal graph, click
Landscape on the Print menu.

Graphing Selected Channels for a Given Period
Situation: You are asked to create a graph for ABCserver showing the input voltage for
phase A/B, the Battery Voltage, and the Battery Time Remaining for the 8-day period from
April 23 at 10 a.m. to May 1 at 10 a.m.

Solution:

1. Create a graph. At the PowerVision Client System Overview, double-click the icon
for ABCserver. The One-line View opens.

2. Frame the time. On the Graph menu, click Properties, and on the Date/Time tab of
the Properties dialog box set a beginning and end time to be charted.

3. Add additional channels. On the Graph menu, click Add Channel.

Charting Selected Parameters for a Given Period
Situation: You are asked to create a table for ABCserver showing the data displayed in
your graph.

Solution:

1. Create a graph. At the PowerVision Client System Overview, double-click the icon
for ABCserver. The One-line View opens.

2. Identify an area of study within your graph, then put your mouse pointer in the
upper left corner of the area, left click and drag to the lower right corner of the
area, and let go. The area appears in a frame.

3. On the Graph menu, click Analysis, then click Range Analysis. The Range Analysis
dialog box opens for you to save, copy to another program, or print.

A chart opens showing for each selected data channel the minimum and
maximum values, the range, the delta, the mean, the media, the standard
deviation, and the trend.
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C H A P T E R 8

CREATING RECORDS OF SYSTEM EVENTS
As events occur in your system, you may find it useful to generate reports and keep
records. For example, you might want to know the exact moment that utility power went
out. You might want to observe events that took place before power went out. You might
want to generate a regular report on data like remaining battery runtime.

PowerVision has extensive facilities for keeping data and generating reports. In addition,
the programs come with a system of notes that can either be system-generated or
user-generated, or both. This chapter covers the following:

S Report options

S Running and retrieving reports

S About PowerVision notes

S Reviewing reports on the Web

Also see “Graphing Your Data” on page 73.

Report Options
On the PowerVision Client File menu, click Reports to run any of the following reports:

S Alarm History (1 Day, 7 Day, 30 Day) – A series of reports listing all alarms detected over
the last day, week, or month. These formats consist of all alarm conditions recorded
within the respective interval. If no alarm events were detected during the period, that
status condition is reported.

S Alarm History Custom – Permits you to specify the range and content of an Alarm History
Report. See “Creating a Custom Report” on page 91.

S Channel Report – Parameters for all channels on a server or a selected device. See
“Creating a Channel Report” on page 92.

S Log File – All recorded events since the last system reset.

S Notes History (1 Day, 7 Day, 30 Day) – All notes logged over the last day, week, or month.

S Notes History Custom – Permits you to specify the range and content of a notes history
report. See “Creating a Custom Report” on page 91.

S Previous Log File – Events recorded in the previous PowerVision Server session.

S System Configuration – Configured Devices, their operational parameters, and current
interface software version.

S System Up-Down – Each time the PowerVision program was launched and terminated.

Creating and Retrieving Reports
Running a PowerVision report compiles its data. You can then retrieve it from the
PowerVision Server and present it locally at the PowerVision Client for display, print, or
incorporation into other programs.

NOTE Administrative User Authorization is required to retrieve a PowerVision report.
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Creating a Report
1. On the PowerVision Client File menu, click Report. The Reports dialog box opens.

Figure 73. Reports Dialog Box

2. In the Reports dialog box, select the folder for a report type. The Run button
becomes active.

3. Click Run.

Naming and Saving a Report
1. In the Reports dialog box, expand the list for a report.

2. Select a report. The Retrieve button becomes active.

3. Click Retrieve. The Save As dialog box opens.

4. Save the report with a file name that enables you to identify it. For example,
assigning the filename Alarm History 101001 to a one-day alarm history file
means the file is an alarm history for October 9-10, 2001.

PowerVision reports are ASCII text files. They provide predefined server information and
thus furnish important insights into system performance. Reports are based on
information in the PowerVision Server. When you retrieve a report, the information is
downloaded to the PowerVision Client. The report can then be reviewed locally, printed,
and distributed to concerned departments or incorporated into other documents.

Report information cannot be modified by the PowerVision Client.
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Opening a Saved Report
1. On the PowerVision Client File menu, click Open. The Open dialog box opens

(see Figure 74).

Figure 74. Open Dialog Box with Reports Selected

2. Select Reports or All Files.

3. Select a Report to open.

Creating a Custom Report
The custom formats allow you to either set a predefined interval or enter a desired period
over which the report is generated. They also allow you to specify the devices or channels
to be included.

To generate a PowerVision Custom Report:

1. On the PowerVision Client File menu, click Report. The Reports dialog box opens.

2. In the Reports dialog box, expand the list of reports available for a server and
click Alarm History Custom or Notes History Custom.

3. Click Run. The Alarm or Notes History Custom dialog box opens.

4. In the Alarm or Notes History Custom dialog box Date/Time tab, click one of the
following:

S Pre-defined Time Interval Report – Requires you to select the Pre-Defined Interval
from the associated list.

S User Selected Time Range Report – Requires that you enter a Starting and Ending
Date/Time to define the span.

The resulting report interval is calculated and shown.
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5. On the Advanced tab, narrow your report to certain channels if desired by
clicking one of the following:

S Include Device or Channel

S Exclude Device or Channel

Clicking one of these buttons opens the Select a Device or Channel dialog box
where you can make your selection.

6. When you click OK to close the Alarm or Notes History Custom dialog box, you
return to the Reports dialog box where a listing for a new custom report appears.

7. Return to “Naming and Saving a Report” on page 90 or “Opening a Saved
Report” on page 91.

Creating a Channel Report
1. On the PowerVision Client File menu, click Report. The Reports dialog box opens.

2. In the Reports dialog box, expand the list of reports available for a server and
select Channel Report.

3. Click Run. The Channel Report dialog box opens (see Figure 75).

Figure 75. Channel Report Dialog Box

4. In the Channel Report dialog box, accept all devices (the default) or limit your
report by selecting a device to be reported on.

5. [Optional] Clear any of the following check boxes which are selected by default:

S Include Alarm Details

S Include Alarm Limits

S Include Alarm Messages

6. When you click OK to close the Channel Report dialog box, you return to the
Reports dialog box where a listing for the new custom report appears.

7. Return to “Naming and Saving a Report” on page 90 or “Opening a Saved
Report” on page 91.
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Notes in PowerVision
PowerVision Notes consist of supplemental information relevant to a particular event.
Notes can be system-entered and user-entered. User-entered notes are limited to 297
characters.

When configured to do so, the PowerVision system automatically enters notes through the
alarm management function.

Configuring System-Entered Notes
1. In the PowerVision Client File menu, point to Administration and click System

Settings. The System Settings dialog box opens.

2. In the System Settings dialog box, select one or more of the following check
boxes:

S Mandatory password for alarm acknowledgement

S Mandatory user note for alarm acknowledgement

S Mandatory logon name in alarm note

See “Changing System Settings” on page 52 for more information.

Creating User-Entered Notes
1. On the PowerVision Server or PowerVision Client File menu, click Add Note.

2. In the Add a Note dialog box, type up to 256 characters in the User Note field.

Reviewing Notes
1. In the PowerVision Client software, click Show Notes in one of the following:

S The Alarms menu (available in the Alarm Management window)

S The Graph menu (available when you open a graph)

S The Servers menu (available in the Server Management window after you select
a server)

The Notes for the current day appear in the graph or window (see Figure 76).

2. Review the notes for the current day (the default) or expand the date field and
select a date from the calendar that opens.



Creating Records of System Events

94 PowerVision® Software User’s Guide S Rev A www.powerware.com

Figure 76. Alarm Management Window with Notes

3. In the Notes window, expand the date box. The date selection calendar opens (see
Figure 77).

Figure 77. Notes Window Date Selection Calendar

4. Select a date.

Accessing Reports on the Web
Before you can access reports via the Web, you must enable your PowerVision Server for
Web access on the server. See “Remote Monitoring via the World Wide Web” on page 41.

Enabling the Server
1. On the PowerVision Server Admin menu, click HTTP Server or HTTPS Server. The

HTTP or HTTPS Server Properties dialog box opens.

2. On the General tab, enable access to the server.



Creating Records of System Events

95PowerVision® Software User’s Guide S Rev A www.powerware.com

Reviewing Reports
1. Verify that your PowerVision Server is enabled for web access.

2. In a Web browser or Palm VII handheld, enter the IP address for the PowerVision
Server. The PowerVision Server Home page opens.

3. Click Reports. A list of reports opens (see Figure 78).

Figure 78. PowerVision WWW Reports

Creating Reports on the Web
1. In the WWW Reports screen, click a report type.

The channel report and custom reports are not supported. The report appears in
the Report 1 column and is available for printing or copying to another file.
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C H A P T E R 9

MAKING CHANGES TO YOUR SYSTEM
Through the life of your system, you are going to make changes in your equipment and
network. You will be adding and removing devices. You will need to add power units. You
may see ways to modify server properties. You will add new users or assign new
responsibilities to existing users. This chapter covers the following:

S Adding and removing devices

S Connecting and removing a server

S Adding a view

S Reconfiguring server properties

S Authorizing user access

S Changing property settings for a device

S Changing the administrator password

S Setting server properties

S Specifying backup file details

NOTE User Authorization is required to modify Server Management.

NOTE Administrative Authorization is required to install new Devices, to alter device properties, to delete
devices, and to alter channel properties.

Adding and Removing Devices (PowerVision Server)
You add new equipment to the PowerVision Server using an installation procedure similar
to that employed during configuration. When you follow the steps below, the Device
Installation Wizard guides you through the process and prompts you to enter the
necessary information.

1. On the PowerVision Server Window menu, click Devices.

2. On the Admin menu, click Start Server Config.

3. Enter password when prompted.

4. On the Edit menu, click Install Device.

5. Follow the Device Installation Wizard:

S Select the type of device

S Enter a name for the device

S Select the type of connection, network or serial.

S Enable Emergency Computer Shutdown [optional]

6. With all Devices properly installed, click No when prompted to install another
device. The Emergency Computer Shutdown Summary opens.
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Figure 79. PowerVision Emergency Computer Shutdown Summary

7. Select the device you are installing and click Next to configure an emergency
computer shutdown or Finish to exit the wizard and return to the PowerVision
Server software.

To configure an emergency computer shutdown, see “Configuring an Emergency
Computer Shutdown” on page 114. If you return to the PowerVision Server
software, click End Server Config on the Admin menu.

Removing Devices
1. On the Admin menu, click Start Server Config.

2. In the Devices window, select the device to be deleted (see Figure 80).

Figure 80. Devices window

3. On the Edit menu, click Delete.

You are cautioned that all current information about the chosen equipment is to
be permanently purged from the server. Logged data regarding the device remains
on your system.

4. Click Yes to remove the Device from the server and return to the previous
PowerVision window, or No to leave the configuration unaffected.

5. On the Admin menu, click End Server Config.
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Connecting and Removing a Server (PowerVision Client)
1. On the PowerVision Client Window menu, click Server Management.

2. On the Servers menu, click New.

3. On the General tab of the Server Properties dialog box, enter a name, a
description of the new server, and the IP address (see Figure 81).

Figure 81. Server Properties Dialog Box

If the PowerVision Server and PowerVision Client software are installed on the
same computer, enter a loopback address of 127.0.0.1.

4. Click OK to close the Server Properties dialog box

5. In the Server Management window, highlight the new server.

6. On the Servers menu, click Connect.

NOTE The selected PowerVision Server must be running for the PowerVision Client to be able to
establish communication.

The PowerVision Client establishes connections with the server. If successful, a
check is placed in front of the Connect command to indicate that the interface is
active.

To establish this server connection automatically when the PowerVision Client
software is launched, enable the Connect at startup setting in the Server
Properties dialog box General tab.

Removing a Server
1. On the PowerVision Client Window menu, click Server Management.

2. Highlight the desired server.

3. On the Servers menu, click Remove.

4. Click OK to confirm the deletion. The server is removed from the Server
Management dialog box.
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Adding a PowerVision View
Adding views allows you to monitor a maximum of 64 icons representing any
combination of servers within a single System Overview.

1. On the File menu, click Add Views.

2. When the Autoview Configuration Wizard starts, follow the prompts.

Reconfiguring Server Properties (PowerVision Client)
To monitor the status and settings of currently configured servers, access the PowerVision
Client Server Management window. To change server properties, access the Server
Properties dialog box.

On the PowerVision Client Window menu, click Server Management. The Server
Management window opens (see Figure 82).

Figure 82. Server Management Window

In the PowerVision Client, software server properties are displayed in the Server
Management dialog box. For each server, the Server Management dialog box lists the
following:

S Address – Set on the General tab of the Server Properties dialog box.

S Server – Set on the General tab of the Server Properties dialog box.

S Description – Set on the General tab of the Server Properties dialog box.

S Status – Current status of the connection between the PowerVision Client and the
PowerVision Server.

S Alarm Updates – Set on the Advanced tab of the Server Properties dialog box.

S Channel Updates – Set on the Advanced tab of the Server Properties dialog box.

S Time Differential – Set on the Advanced tab of the Server Properties dialog box.

S Offline Sound – Set on the Advanced tab of the Server Properties dialog box.

Changing Server Properties
1. On the PowerVision Client Window menu, click Server Management.

2. In the Server Management dialog box, highlight a server.

3. On the Servers menu, click Properties. The Server Properties dialog box opens
displaying the General tab (see Figure 83).
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Figure 83. Server Properties Dialog Box General Tab

4. Change the General tab of the Server Properties dialog box as follows:

S Name – User-entered to identify the unit.

S Description – User-entered comment, usually to identify the unit.

S Address – The IP address of the computer running the PowerVision Server
software. This address must be correct or communication cannot be established
between this computer and the PowerVision Client. To change an address,
select it and click Properties. Enter an IP address or computer name. If the
PowerVision Server and PowerVision Client software are installed on the same
computer, enter a loopback address of 127.0.0.1.

S Connect at startup – When selected, automatically connects you to the selected
server when you start the PowerVision Client software.

S System Alarms – When selected, automatically reports server-level errors in
addition to any channel cautionary or critical alarm limit excursions.
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5. Click the Advanced tab of the Server Properties dialog box. The Server Properties
dialog box opens displaying the Advanced tab (see Figure 84).

Figure 84. Server Properties Dialog Box Advanced Tab

6. Change the Advanced tab of the Server Properties dialog box as follows:

S Server Offline Sound – The file which audibly reports a particular alarm
condition. To select a sound, expand the Sound list or Browse for another
*.wav file in your system. A sound selected from outside the PowerVision
software or Windows program files remains active only as long as it is the
chosen sound.

S Realtime Server Updates (Channel Values) – The default is Specify channel value
update interval with channel values updated every second. The default update
interval of one second is recommended for most installations, although to
allow for the processing required to report a large number of channels, it
should be increased in installations with multiple servers running the
PowerVision Server software. Select the Disable channel value updates option
when you want to display reported alarm conditions only.

S Realtime Server Updates (Alarms) – The default update interval of one second is
recommended for most installations, although to allow for the processing
required to report a large number of channels, it should be increased in
installations with multiple servers running the PowerVision Server software.

S Time Differential – An adjustable setting to account for any time zone difference
between the computers running the PowerVision Server and the PowerVision
Client software. Enter the offset, in one-hour increments. Units in the same
time zone use the default setting of “0.” If, for example, one unit is located in
Los Angeles and the other is in Chicago, the time differential is “-2.”

S Password – Click Change Password to open the Change Server Password dialog
box to change the password for the PowerVision Server.



Making Changes to Your System

103PowerVision® Software User’s Guide S Rev A www.powerware.com

Authorizing User Access
It is possible to have just one user with access to all parts of your system, but it is also
possible to authorize one or more users with access limited to one or more of the
following settings:

S Administration

S Alarm Properties

S Alarm Acknowledge

S Alarm Rearm

S View Editing

S Console Access

S Server Administration

S Report Run

S Report Retrieval

S Report Scheduling

S Backup

S Restore

S Edit Messaging Configuration

S SNMP

S View Configuration

S Channel and Device Parameter Modification

S Stop Messaging Calls

S Suspend Messaging Calls

S Select Server Address

Defining a New User
1. On the PowerVision Client Users menu, click Edit User Configuration. The User

List dialog box opens (see Figure 85).

Figure 85. User List Dialog Box

2. In the User List dialog box, click New. The New User dialog box opens (see
Figure 86).
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Figure 86. New User Dialog Box

3. In the New User dialog box, complete the name fields for the new user.

4. Enter the password in the Password and Verify Password fields. Passwords are
case-sensitive.

5. Enable the settings to which this user has authorization.

If only one user exists on the list, that person is given full access to all functions.
For that reason, it is suggested that access privileges be limited in multiuser
environments.

Deleting a User
1. In the User List dialog box, highlight the user.

2. Click Remove.

Changing User Settings
1. On the PowerVision Client Users menu, click Edit User Configuration. The User

List dialog box opens (see Figure 85).

2. In the User List, select the name of a person and click Edit. The Edit User dialog
box opens (see Figure 87).
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Figure 87. Edit User Dialog Box

3. In the Settings area of the Edit User dialog box, select or clear the check box
before the settings; selecting a check box allows access to the associated function.

4. To change the selected user’s Password, click Change Password.

You can also change users without quitting the program. On the Users menu click Login as
New, then enter the alternate user name and that person’s authorized password (or that of
one with Administration privileges).

Changing the Password
1. On the Users menu, click Select Change Password for [User]. The Change

Password for [User] dialog box opens (see Figure 88).

Figure 88. Change Password for [User] Dialog Box

2. In the Change Password for [User] dialog box, enter the old password for the
named user. Passwords are case-sensitive.

3. Enter the new password in the New password and Verify password fields.

Changing Property Settings for a Device
Device properties you can change include the number of log messages to be stored and
communication settings. Properties intended for review and not to be changed include
device identification and description details.

The Device Properties dialog box can be viewed, but not modified unless the server is in
the configuration mode.

1. In the PowerVision Server Devices window, select a device.

2. On the Admin menu, click Start Server Config.
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3. Select the desired device.

4. On the Edit menu, click Properties. The Device Settings dialog box opens with the
following tabs (see pages 106 through 109).

S General

S Version

S Basic

S Advanced

S Port Settings

S Wiretap

5. Close this dialog box.

6. On the Admin menu, click End Server Config.

Device Properties General Tab
The Device Properties General tab is shown in Figure 89.

Figure 89. Device Properties General Tab

Properties you can change are:

S Adjust the amount of messages written to Log file – Enter a value up to 999. Note that a
larger log file requires greater disk space. Value returns to 2 (the default) if you refresh
identification information from device.

Properties you can review are:

S Identification Information from Device – Click Refresh.

Properties you cannot change are:

S Device Description – This information is supplied by the user at installation.

S Identification Information from Device – This information is supplied by the user at
installation.
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Device Properties Version Tab
This is review information supplied by the user at installation. You may be asked for this
information if you call Technical Support.

Device Properties Basic Tab
The Device Properties Basic tab is shown in Figure 90.

Figure 90. Device Properties Basic Tab

Properties you can change are:

S Device Disabled – When checked, data is not archived to the PowerVision Server.
Disabling a device is useful when making repairs to avoid archiving inappropriate
readings.

S Device Disarmed – When checked, suspends alarm limit testing for one hour on all
channels on this device. Data, however, continues to be archived. Disarming a device is
useful when making repairs to avoid reporting nuisance alarms.
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Device Properties Advanced Tab
The Device Properties Advanced tab is shown in Figure 91.

Figure 91. Device Properties Advanced Tab

Communication settings properties you can change are:

S Communication Retries – The number of times communication is attempted when a
Device command is unsuccessful.

S Scan Interval – The delay (in milliseconds) between data polls of the device.

S First-char Timeout – How long (in milliseconds) to wait for a response from the device
after issuing a command.

S Inter-char Timeout – The period of silence (in milliseconds) to wait during a Device
response before determining the message is complete.

S Terminal Server Connection – When selected, indicates the device is physically attached
to a terminal server.
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Device Properties Port Settings Tab
The Device Properties Port Settings tab is shown in Figure 92.

Figure 92. Device Properties Port Settings Tab

If your connection is to a serial port, properties you can change are:

S Port – How the device or modem is connected to the PowerVision Server.

S Current Device Settings – Baud rate, data bits, parity, and stop bits.

If your connection is to a network, you can change the following property:

S IP Address – The IP address for the device.

Device Properties Wiretap Tab
This section is a debug tool for device driver development by the manufacturer and
DataTrax Systems. Use this tool to provide error information to Powerware if the Help
Desk asks for proof to DataTrax that the device driver is not working properly with a
certain UPS.

Changing the Administrator Password
On the Users menu, click Change Password for Admin. Enter changes in the Change
Password for Admin dialog box (see Figure 93).

Figure 93. Change Password for Admin Dialog Box
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Setting Server Properties (PowerVision Server)
Use the Server Properties dialog box to specify remote settings. These settings can be
useful in unattended monitoring.

1. On the Admin menu, click Server Properties. The Server Properties dialog box
opens (see Figure 94).

Figure 94. Server Properties Dialog Box

Use the Server Properties dialog box to change the following:

S Auto-start the client – If enabled, this setting automatically boots the PowerVision Client
each time you start the PowerVision Server. To activate this setting, the PowerVision
Server and the PowerVision Client software must both reside on the same computer.

S Logging Level – Do not alter this field unless directed to do so by Powerware personnel.
Changing this setting could result either in excessive data archiving or potential data
loss.

S Server Name – This entry identifies this server whenever it is reported, as in message
functions. The name can be a maximum of 29 characters, with the default server name
the default entry.

S Allow Remote Restart of the Server Application – If enabled (default), this setting permits
authorized computers running the PowerVision Client software to remotely reinitialize
the PowerVision Server.

S Allow Remote Restart of the Operating System – If enabled (default), this setting permits
authorized computers running the PowerVision Client software to remotely perform a
complete reboot of the computer running the PowerVision Server software. This setting
should be disabled on servers where the autologin function is not used.
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S Allow Remote Upgrade of the Server Application and Device Drivers – If enabled (default),
this setting permits authorized computers running the PowerVision Client software to
install newer versions of the software as they are released. This approach allows
personnel to upgrade the server without having to physically be on site at remote
installations. To perform this operation, a network connection with file sharing is
required on the PowerVision Server.

S Secondary Data Path – This entry identifies the optional location for historic databases.
This can be on another disk or on another computer.

Specifying Backup File Details
Anytime you change your PowerVision Client, you are advised to create a backup copy for
future sessions and as a disaster recovery precaution.

1. On the File menu, point to Administration and click Backup. The Backup dialog
box opens (see Figure 95).

2. In the Backup dialog box, create or select a backup (.arq) file.

Figure 95. Backup Dialog Box

3. Select the appropriate check boxes to include bitmap files, system logs,
configuration files, and message management configuration files.

The Restore procedure retrieves the file created for backup.
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C H A P T E R 10

EMERGENCY COMPUTER SHUTDOWN
This chapter describes the basic steps for configuring an emergency computer shutdown
and for disabling the shutdown function for a device. It also includes a section on
Powerware Shutdown Agent operations.

PowerVision monitors critical power devices on a 24 hours per day, 7 days per week basis.
Support for servers is generally provided by UPSs backed up by generators. For the rare
event of an emergency where the UPS is on battery and the UPS battery power is low, you
can configure your network so computers are shut down.

The PowerVision Server Emergency Computer Shutdown option is for managing and
controlling the shutdown of dependent computer systems which have been configured as
shutdown groups. The computers within a shutdown group must be running the
Powerware Shutdown Agent in any of the following operating systems:

S Windows NT 4.0, Windows 95/98, Windows 2000, Windows Me, Windows XP

S Novell NetWare 4.11 (TCP/IP required) and above

S HP-UXR 10.2+, Sun Solarist 2.6+ (SPARCR), IBMR AIXR 4.2+, LinuxR (with kernel 2.2)

Configure an emergency shutdown by creating a shutdown group and defining its
properties. Figure 96 shows the communication within a typical subnet with one
computer running the PowerVision Server software.

Segment A

Segment B

Segment C

Internet

PowerVision
Server

Application

Powerware
Shutdown
Agent

Powerware
Shutdown

Agent

Powerware
Shutdown
Agent

Router

HubPowerware UPS
with ConnectUPS

Figure 96. Configuration of Current Shutdown Group

Shutdown groups are shut down by a command from a computer running the
PowerVision Server software when it receives an alert (low battery alert is the default)
from its supporting UPS. Since shutdown commands are triggered by a UPS status
message, the configuration of one shutdown group should be limited to the computers
supported by the same UPS.
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Configuration is done in the PowerVision Server software by running the Shutdown
Configuring Wizard. The wizard’s discovery process searches the network segment of the
computer running the application, looking for computers with the Powerware Shutdown
Agent installed. To include computers from other segments, perform a subnet discovery.
Computers can also be manually added to the shutdown group.

NOTE This function is for emergency shutdowns. It is assumed you have configured an alert notification
system so key personnel are aware of the situation mandating the shutdown. See “Notifying Personnel of
Alarms and Alerts” on page 61.

NOTE This function shuts down the operating system of designated servers or computers when the UPS
low battery setting is reached. PowerVision does not shut down UPSs. Refer to your UPS documentation or
contact your local Powerware representative for instructions on configuring the low battery setting.

NOTE Emergency Computer Shutdown is a new feature with PowerVision v.3.0. If you have been running a
previous version of PowerVision and wish to use the Emergency Computer Shutdown function, you must
delete the devices in the PowerVision Server Devices window and reinstall them enabling Emergency
Computer Shutdown.

Configuring an Emergency Computer Shutdown
To configure an emergency shutdown of a computer or computers supported by a UPS
device, perform the following steps:

1. Make a list – Make a list of your system servers and computers with the IP address
and supporting UPS for each. See “Listing Server and Device Details” on page 25.

2. Check your installed devices – Devices supporting the computers to be shut down
must appear in the PowerVision Server Devices window. If you installed the
devices using a version of PowerVision prior to version 3, you must delete the
devices from the Devices window and reinstall them. The Device Installation
Wizard in version 3 and later includes a check box for enabling shutdowns which
must be selected before shutdowns can be configured and enabled. See “Adding
and Removing Devices” on page 97.

3. Install the shutdown agent – Verify that you have installed the shutdown agent on
each critical server on the network. See the following section, “Installing the
Powerware Shutdown Agent.”

4. Configure the Emergency Shutdown – See “Creating a Shutdown Group and
Configuring the Emergency Shutdown” on page 115.

5. Test your computer shutdown functions – See “Testing the Emergency Computer
Shutdown Function” on page 118.

Installing the Powerware Shutdown Agent
You must install the Powerware Shutdown Agent on any server you designate for
shutdown. Installation is as follows:

S Windows Systems – On the Software Suite CD, navigate to \PV\SDA\Win32 and run
sdagent.exe.

S Novell NetWare – On the Software Suite CD, run load
cd_volume:\PV\SDA\Novell\sdasetup. Optionally, copy the following files to a
temporary directory on your Novell system: sda.pum, sdagent.nlm, sdasetup.nlm,
shutdown.ncf, and uninstall.nlm. Then run load sys:\tempdir\sdasetup.



Emergency Computer Shutdown

115PowerVision® Software User’s Guide S Rev A www.powerware.com

S UNIX Systems – On the Software Suite CD, navigate to \PV\SDA\UNIX and run
./install.sh. Optionally, copy the distribution program file sda.XX.YY.tar (where XX is
the Major Version and YY is the Minor Version) and the install script install.sh to a
directory on your UNIX system.

Installation options are as follows:

- Install path – Accept the default path or specify an alternative.

- Automatic startup – Recommend accepting the default so the Powerware Shutdown
Agent starts automatically with each system reboot.

NOTE For a list of installed files and their descriptions, see page 121 and page 122.

Creating a Shutdown Group and Configuring the Emergency Shutdown
1. Do one of the following:

S After you install a device the PowerVision Emergency Computer Shutdown
Summary opens.

S On the PowerVision Server File menu, point to Emergency Computer
Shutdown and click Start the Configuration Wizard. The PowerVision Emergency
Computer Shutdown Summary opens (see Figure 97).

Figure 97. PowerVision Emergency Computer Shutdown Summary

2. Select the device supporting the computers to be shut down and click Next.

3. The Select Clients dialog box opens and the system searches the local network of
your computer for other computers running the PowerVision Shutdown Agent.
The hostnames for these computers appear in the left pane of the Select Clients
dialog box (see Figure 98).
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Figure 98. Available Shutdown Clients Found by System

4. Create the Current Shutdown Group for the UPS. If the UPS powers a computer
in the Available Shutdown Clients area, select the computer and click >>, moving
the computer or computers to the Current Group area (see Figure 99).

Figure 99. Current Shutdown Group Configured by User

5. If your UPS supports computers in other network subnets, click SubNet Discovery.
The Manual Broadcast dialog box opens. Type the subnet number as
xx.xxx.xx.255 and click OK. Discovered computers are added to the list of
Available Shutdown Clients.

6. To add other computers to the Current Shutdown Group, click Enter Address. The
Manual Client Entry dialog box opens. Type the IP address or hostname and
click OK.

7. Click Next. The Shutdown Client Properties dialog box opens (see Figure 100).



Emergency Computer Shutdown

117PowerVision® Software User’s Guide S Rev A www.powerware.com

Figure 100. Shutdown Client Properties Dialog Box

8. To edit client properties, select the client. You can change either of the following:

S Delay Time – The interval between the low battery alert and the moment when
the workstation initiates its shutdown. This interval allows the system
administrator to sequence the shutdown so the most critical servers are shut
down last. Refer to your UPS documentation or contact your local Powerware
representative for instructions on configuring the low battery setting.

S Password – This makes shutdown a password-controlled function. Passwords
can be individualized by computer or server.

9. Click Next. The Finish dialog box opens.

Figure 101. Finish Dialog Box

NOTE By default, if you enable shutdowns, the computer shuts down if the UPS is on battery and the
battery is low. Changing the defaults is not advised without Powerware technical support. To change
defaults, edit the user-defined equation for the Emergency Computer Shutdown channel.
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Testing the Emergency Computer Shutdown Function
This is a pre-test of Emergency Computer Shutdown function. It does not shut down a
system, but checks to see if a group’s clients are on line and would shut down if a
shutdown message was sent to the UPSs. If contact it successful, it is shown in the report
that is generated at the conclusion of the test.

1. On the File menu, point to Emergency Computer Shutdown and click Start the
Configuration Wizard. The Wizard Summary dialog box opens.

2. Select a device and click Shutdown Test.

The system checks client IP addresses and links and tests communication with remote and
local clients. A report is generated and opens on your screen.

Disabling the Shutdown Function
When you disable the emergency computer shutdown channel for a device and remove
the device from a shutdown group, you disable the emergency computer shutdown
function for all the computers it supports.

Disabling the Emergency Computer Shutdown Channel
1. In the Emergency Computer Shutdown channel properties, select the Channel

Disabled check box.

2. In the PowerVision Server Devices window, select the device and expand its list of
channels.

3. Select the Emergency Computer Shutdown channel and open its Channel Properties
dialog box.

4. Select the Channel Disabled check box (see Figure 102).

Figure 102. Emergency Computer Shutdown Channel Properties
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Removing a Device from a Shutdown Group
1. In the Computer Shutdown Wizard, reconfigure the computers that are attached

to the device.

2. On the PowerVision Server File menu, point to Emergency Computer Shutdown and
click Start the Configuration Wizard. The Select Clients dialog box opens and the
system searches your local subnet. When the search is complete, all computers in
the shutdown group appear in the right pane (see Figure 99).

3. In the Current Group (right pane), select a device to be removed and click <<.
The device appears on the available shutdown clients list in the left pane (see
Figure 98).

4. Click Next. The Shutdown Client Properties dialog box opens (see Figure 100).

5. Click Next. The Finish dialog box opens (see Figure 101).

6. Click Finish. The PowerVision Emergency Computer Shutdown Summary opens
(see Figure 97).

7. Click Finish. A new .ini file is generated, overwriting the existing one. This
completes the removal of the device.

Powerware Shutdown Agent Operations
The following sections cover procedures for:

S Shutting down specific programs before the operating system.

S Changing the unique ID of the local host.

S Setting the ports for discovery or communication.

S Limiting the IP addresses to which the Powerware Shutdown Agent responds.

S Shutting down the Powerware Shutdown Agent.

S Uninstalling the Powerware Shutdown Agent.

Shutting Down Specific Programs Before the Operating System
In a text editor or word processor, open the appropriate file from the following list:

S Windows Systems – shutdown.bat

S Novell NetWare – shutdown.ncf

S UNIX Systems – sda.shutdown

These files contain the shutdown command for the system. Add shutdown commands for
specific applications before the system shutdown command.

Changing the Unique ID of the Local Host
The installation program proposes a default value or hostname. You can change this value,
but you must verify that the new value is unique to all instances of the Powerware
Shutdown Agent that the PowerVision Server can see.

1. In a text editor, open sda.cfg.

2. Change the value for UniqueID.
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Setting the Ports for Discovery or Communication
Create either or both of these values if you are having problems because another software
program indiscriminately uses the same port or ports. The value you specify forces the
program to use the value for discovery or communication with the PowerVision Server.

1. In a text editor, open sda.cfg.

2. Specify a value for DiscoveryPort or CommunicationPort.

Limiting the IP Addresses to Which the Powerware Shutdown Agent Responds
By default, the Powerware Shutdown Agent responds to shutdown commands from any IP
address. You can specify that the Powerware Shutdown Agent respond only to shutdown
commands from a specific IP address or addresses. Enter each IP address on a separate
line. You may specify up to 16 IP addresses.

1. In a text editor, open sda.cfg.

2. Change the value for ResponseIP per the following example:

ResponseIP=12.345.678.90
12.345.678.91
12.345.678.92
12.345.678.93
12.345.678.94

Shutting down the Powerware Shutdown Agent
S Windows 95/98, Windows Me – Press the Ctrl+Alt+Delete keys. On the Close Program

dialog box, select pwagdmon and click End Task.

S Windows NT, Windows 2000, and Windows XP – On the Start menu, point to Settings and
click Control Panel. On the Control Panel, open the Services icon. In the Services dialog
box, select Powerware Shutdown Agent and click Stop.

S Novell NetWare – Type unload sdagent. The module sdagent.nlm is unloaded.
Optionally, uninstall the Powerware Shutdown Agent.

S UNIX – Run the script /usr/sda/sda.init stop.

Uninstalling the Powerware Shutdown Agent
Windows Systems – Perform the following steps:

1. On the Start menu, point to Settings and click Control Panel. The Control Panel
opens.

2. On the Control Panel, open the Add/Remove Programs icon. The Add/Remove
Programs Properties dialog box opens.

3. In the Add/Remove Programs Properties dialog box, select Powerware Shutdown
Agent and click Add/Remove.

Novell NetWare – Run LOAD SYS:\sda\uninstal. The uninstall stops the Powerware
Shutdown Agent, removes the autostart files, removes the files from the Powerware
Shutdown Agent directory, and removes the Powerware Shutdown Agent’s install
directory.

UNIX Systems – From outside the /usr/sda directory, run /usr/sda/uninstal.sh.
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Windows Files
Table 4 is a list of files and their descriptions installed with the Powerware Shutdown
Agent in Windows systems.

Table 4. Powerware Shutdown Agent Files for Windows

File Name Description

sdagent.exe Shutdown agent program for Windows 95, Windows 98, and Windows Me

pwagsrvc.exe Shutdown agent service for Windows NT, Windows 2000, and Windows XP

Pw_popup.exe Message popup program

sda.stt System file

sda.pwd System file

sda.par System file

sda.cfg System file

sda.cmt System file

sda.act System file

sda.pum System file

sda.acc System file

shutdown.bat Batch file which user can open in a text editor to modify so specific programs are shut
down before the operating system

shutdown.exe System and application shutdown program

shutdown.cfg Configuration file for shutting down applications

Novell NetWare Files
Table 5 is a list of files and their descriptions installed with the Powerware Shutdown
Agent in Novell NetWare systems.

Table 5. Powerware Shutdown Agent Files for Novell NetWare

File Name Description

sdagent.nlm Shutdown agent

shutdown.ncf Shutdown script modifiable file to shut down critical applications before the operating
system

uninstal.nlm Uninstall script

sda.stt System file

sda.pwd System file

sda.par System file

sda.cfg System file

sda.cmt System file

sda.act System file

sda.pum System file

sda.acc System file
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UNIX Files
Table 6 is a list of files and their descriptions installed with the Powerware Shutdown
Agent in UNIX systems.

Table 6. Powerware Shutdown Agent Files for UNIX

File Name Description

sdagent Shutdown agent daemon

sda.shutdown Modifiable shutdown script file to shut down critical applications before the operating
system

uninstal.sh Uninstall script

sda.init Script file that starts, stops, or initializes the Shutdown Agent daemon

sda.stt System file

sda.pwd System file

sda.par System file

sda.cfg System file

sda.cmt System file

sda.act System file

sda.pum System file

sda.acc System file
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C H A P T E R 11

INTEGRATING BUILDING MANAGEMENT SOFTWARE AND

POWERVISION
PowerVision Server software supports the ModbusR open standard for systems integration.
A computer running building management software can use the PowerVision Modbus
Gateway virtual device to access UPS data. Data is read only, analog for metered
information, and digital for status information.

This chapter describes the steps necessary for accessing UPS data through building
management software and the PowerVision Modbus Gateway. These steps are as follows:

1. Install PowerVision Modbus Gateway as a virtual device in the PowerVision
Server software.

2. [Optional] Change the gateway addresses.

3. Connect the computer running the PowerVision Server software into the Modbus
network.

4. Retrieve the data.

This document assumes you understand how to operate your building management
software. This document provides basic instructions for using the PowerVision software to
generate data. Further information for the PowerVision software is available on the Help
menus.

Installing the PowerVision Modbus Gateway Virtual Device
This step makes the PowerVision Server software able to process data in a form that your
building management software can interpret. Install the PowerVision Modbus Gateway as
a virtual device. See “Installation” on page 21 or the PowerVision Server Help Index for
information on installing devices.

1. On the PowerVision Server Admin menu, click Start Server Config. When
prompted, click Yes to end your database session.

2. On the Edit menu, click Install Device. The Device Installation Wizard opens.
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3. Use the Device Installation Wizard to install the PowerVision Modbus Gateway,
noting the following:

S When the wizard prompts you to select a device, select PowerVision Modbus
Gateway (see Figure 103).

Figure 103. Device Installation Wizard

S After you finish the Device Installation Wizard, the Modbus Gateway icon
appears in the PowerVision Server Devices window (see Figure 104).

Figure 104. Devices Window with Modbus Gateway Icon

S On the Admin menu, click End Server Config to return to normal operations.

Viewing and Changing Addresses
The PowerVision Modbus Gateway virtual device and all UPS devices in the gateway have
a default address of 1. For performance, and to resolve conflicts, you may wish to
individualize the gateway addresses. Remember that if you change one gateway address,
you must change the gateway address for each device in the PowerVision Server Devices
window.

To verify the address from the PowerVision Server Devices window, select a device and
open its Device Settings dialog box by clicking Properties on the Edit menu. When the
Device Settings dialog box opens, click the Gateway tab (see Figure 105).
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Figure 105. Device Settings Dialog Box Gateway Tab

When the PowerVision Server is operating normally (in a database session), the device
settings are read only. To change the settings, you must end the database session and go to
Server Config mode. This is done from the Admin menu.

Changing the Gateway Address

NOTE If address 1 is already in use, you can change the gateway address, but if you change one gateway
address, you must change the gateway address for each device in the PowerVision Server Devices window.

1. On the PowerVision Server Admin menu, click Start Server Config. The icons in
the Devices window change to purple.

2. Select a device and click Properties on the Edit menu. The Device Settings dialog
box opens and can be edited.

3. After completing your edits, return to the Admin menu and click End Server
Config. The PowerVision Server software restarts.
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Connecting the PowerVision Server into the Modbus Network
The computer running the PowerVision Server software is hardwired to the Modbus
network. You can choose between an RS-485 setup or a TCP/IP setup.

Connecting to an RS-485 Modbus Network
In an RS-485 network, the RS-232 Modbus output of the PowerVision Server is attached
to the DB-25 port of an RS-232/RS-485 converter. The converter, Telebyte Model 245, is
Powerware part number 41168. The output is a 2-wire/4-wire twisted-pair cable sold by
the foot as Powerware part number 14022.

Connecting to a Modbus TCP/IP Network
In a TCP/IP network, the RS-232 output of the PowerVision Server is attached to the DB-9
port of a control single-port device master, Powerware part number 41146. The output to
the Modbus/TCP network is RJ-45 UTP Ethernet cat 3 cable.

Retrieving the Data
Before you can retrieve PowerVision data in your building management software, you
must create a PowerVision Client report listing the register numbers for the Gateway
Configuration. Your building management software presents data by register numbers.
The register number report is the key to the meaning of the register numbers.

NOTE Each time you add or remove equipment from your system, the gateway configuration changes and
you must create a new Gateway Configuration report.

To obtain a list of register numbers for the monitored UPSs, use the PowerVision Client
software to create a Gateway Configuration report. Before you can open and print the
report, you must run the report, retrieve, and save it.

Creating a Report
1. On the PowerVision Client File menu, click Report. The Reports dialog box opens

(see Figure 106).

2. In the Reports dialog box, select the Gateway Configuration folder. The Run button
becomes active.

3. Click Run. You can now expand the Gateway Configuration folder to access the
report.
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Figure 106. Reports Dialog Box

Retrieving and Saving a Report
1. In the Reports dialog box, expand the Gateway Configuration folder.

2. Select a report. The Retrieve button becomes active.

3. Click Retrieve. The Save As dialog box opens.

4. Save the report with a file name that enables you to identify it. The report opens
in WordPad for printing.

NOTE It is recommended that you save the report as a *.txt file.

5. Move the report file to the computer running the building management software.

NOTE The PowerVision Modbus Gateway report is an ASCII text file that can be read by a text editor.
Report information cannot be modified by PowerVision.

NOTE The PowerVision Server Gateway Configuration report provides the register offset numbers that your
building management software needs to interpret the data channels for each particular UPS.

NOTE Register offset numbers are unique to each UPS, even if you have two of the same kind of UPSs.
Be sure to follow the report verbatim.

NOTE Each time you add or remove equipment in your system, the gateway configuration changes and you
must create a new Gateway Configuration report.

The PowerVision Server software generates two types of raw data when you read holding
registers from your building management software (function 03, Read Holding Registers,
register number in the 40000 value range):

S Analog data (the Meters channel data in PowerVision)

S Digital data (the Status channel data in PowerVision)
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The analog data is shown in whole numbers because the PowerVision gateway function
does not support floating point data. Although the information to the right of the decimal
is dropped, it can be viewed in the PowerVision Server software by accessing the channel
properties.

The digital data can be read in one of the following ways:

S Specified Bit – A specified bit within a register using the notation rrrr:b, where rrrr
specifies a valid holding register and b specifies the correct bit position between 1 and
16 (1 specifying the most significant bit). In the PowerVision Modbus Gateway, when
bit 1 is equal to 1, it is equal to a Logical 1 or True.

S Hexadecimal – A value of 8000H is equal to a logical 1 or True. A value of 0 equals a
logical 0 or False.

S Unsigned decimal – A value of 32768 is equal to a logical 1 or True. A value of 0 equals a
logical 0 or False.

Table 7 shows a typical set of PowerVision Meters channels (PowerVision Modbus
Gateway tag type analog) with example register offset numbers, units of measure, and
example values.

Table 7. Example Meters Channel Data (Analog)

Register Offset Number Channel Unit Example Scale Value

43 Ambient Temperature degree Celsius 27

41 Battery Time Remaining minute 60

40 Battery Voltage volt 55

35 Input Current ampere 2

39 Input Frequency hertz 60

42 Input Voltage volt 120

44 Output Current ampere 1

38 Output Frequency hertz 60

37 Output VA volt-ampere 210

45 Output Voltage volt 121

36 Output Watts watt 121

48 Time Elapsed Since Last Request second 1
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Table 8 shows a typical set of PowerVision Status channels (PowerVision Modbus
Gateway tag type digital). Data includes an example register number, the channel name,
and the alarm on value. Use the PowerVision Server software to verify a channel’s alarm
on value by checking the channel properties in the Devices window. Refer to the
PowerVision Client Gateway Configuration report for register number values.

Table 8. Example Status Channel Data (Digital)

Register Offset Number Channel Alarm on Value

33 Ambient over temperature True

34 Auto shutdown pending True

32 Batteries disconnected True

21 Battery Low True

23 Battery over voltage True

30 Battery test failed True

25 Bypass is not available True

20 Charger status True

18 DC link over voltage True

29 DC start occurred True

8 Device communication True

11 Input over voltage True

12 Input under voltage True

13 Input under/over frequency True

24 Inverter control board test True

17 Inverter output over current True

19 Inverter Status True

28 Low battery shutdown True

9 Output over voltage True

15 Output overload True

10 Output under voltage True

16 Rectifier input over current True

14 Remote EPO True

31 Site wiring fault True

27 UPS in maintenance bypass True

47 UPS normal False

26 UPS on battery True

46 UPS on bypass True

22 Utility not present True
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